OpenVox

UC501 User Manual

OpenVox

OpenVox Communication Co., Ltd

UC501 User Manual

Version 1.0

1
OpenVox Communication Co. , LTD. URL: www.openvox.cn



OpenVox

UC501 User Manual

OpenVox

OpenVox Communication Co.,Ltd

Address: Room 624, 6/F, Tsinghua Information Port, Book Building, Qingxiang Road,
Longhua Street, Longhua District, Shenzhen, Guangdong, China 518109

Tel: £86-755-66630978, 82535461, 82535362

Business Contact: sales@openvox.cn

Technical Support: support@openvox.cn

Business Hours: 09:00-18:00(GMT+8) from Monday to Friday

URL: www.openvox.cn

Thank You for Choosing OpenVox Products!

2
OpenVox Communication Co. , LTD. URL: www.openvox.cn


mailto:support@openvox.cn

OpenVox

UC501 User Manual

Revision History

Issue version

Issue date

Detail of change

1.0

Apr. 9th, 2019

Initial

OpenVox Communication Co. , LTD.

URL: www.openvox.cn

3



OpenVox

UC501 User Manual

Copyright
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without prior written permission.

Confidentiality

Information contained herein is of a highly sensitive nature and is confidential and proprietary to OpenVox Inc.
No part may be distributed, reproduced or disclosed orally or in written form to any party other than the direct
recipients without the express written consent of OpenVox Inc.

Disclaimer

OpenVox Inc. reserves the right to modify the design, characteristics, and products at any time without
notification or obligation and shall not be held liable for any error or damage of any kind resulting from the
use of this document.

OpenVox has made every effort to ensure that the information contained in this document is accurate and
complete; however, the contents of this document are subject to revision without notice. Please contact
OpenVox to ensure you have the latest version of this document.

Trademarks

All other trademarks mentioned in this document are the property of their respective owners..
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FCC Part 68

1.

10.

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the ACTA. On
the bottom of this equipment is a label that contains, among other information, a product identifier in the
format US:AAAEQ##TXXXX. If requested, this number must be provided to the telephone company.

A plug and jack used to connect this equipment to the premises wiring and telephone network must
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant
telephone cord and modular plug is provided with this product. It is designed to be connected to a
compatible modular jack that is also compliant. See installation instructions for details.

If this equipment [US: G4DIS01AUCS501] causes harm to the telephone network, the telephone company
will notify you in advance that temporary discontinuance of service may be required. But if advance
notice isn't practical, the telephone company will notify the customer as soon as possible. Also, you will
be advised of your right to file a complaint with the FCC if you believe it is necessary.

The telephone company may make changes in its facilities, equipment, operations or procedures that
could affect the operation of the equipment. If this happens the telephone company will provide advance
notice in order for you to make necessary modifications to maintain uninterrupted service.

If trouble is experienced with this equipment [US: G4DIS01AUC501], for repair or warranty information,
Service can be facilitated through our office at:
U.S. Agent Company name: WinWealth Tech Inc.
Address: 170 W Pomona Ave Monrovia, CA 91016 USA
Tel: +1 6262400785, +1 6265741300
Fax: +1 626 574 1300
If the equipment is causing harm to the telephone network, the telephone company may request that you
disconnect the equipment until the problem is resolved.

Please follow instructions for repairing if any (e.g. battery replacement section); otherwise do not alternate
or repair any parts of device except specified. For repair procedures, follow the instructions outlined under
the limited warranty.

Connection to party line service is subject to state tariffs. Contact the state public utility commission,
public service commission or corporation commission for information.

If your home has specially wired alarm equipment connected to the telephone line, ensure the installation
of this UC501 does not disable your alarm equipment. If you have questions about what will disable alarm
equipment, consult your telephone company or a qualified installer.

If the telephone company requests information on what equipment is connected to their lines, inform them
of:

a) Theringer equivalence number [0.1]

b) The USOC jack required [RJ11C]

c) Facility Interface Codes (“FIC”) [02LS2, 04DU9-BN, 04DU9-DN, 04DU9-1KN, 04DU9-1SN]

d) Service Order Codes (“SOC”) [N/A]

e) The FCC Registration Number [US: GADIS01AUC501]

The REN is used to determine the number of devices that may be connected to a telephone line. Excessive
RENSs on a telephone line may result in the devices not ringing in response to an incoming call. In most
but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the number of devices
that may be connected to a line, as determined by the total RENS, contact the local telephone company.
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The REN for this product is part of the product identifier that has the format US:AAAEQ##TXXXX. The
digits represented by ## are the REN without a decimal point. For this product the FCC Registration
number is [US: G4DIS01AUC501] indicates the REN would be 0.1.

11. We suggest the customers use a surge arrestor to protect the device.

Caution - To ensure proper operation, this equipment must be installed according to the enclosed installation instructions. To verify that

the equipment is operating properly and can successfully report an alarm, this equipment must be tested immediately after installation,
and periodically thereafter, according to the enclosed test instructions.«
"

Caution - Verification of Line Seize capability should be made immediately after installation, and periodically thereafter, in order to

ensure that this equipment can initiate a call even when other equipment (telephone, answering system, computer modem, etc.)
connected to the same line is in use.«
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1 Overview

1.1 Introduction

UCS501 IPPBX is an upgraded version of UC500. It can be pre-installed with OpenVox IPPBX
system or other open-source communication system chosen by customers. It has built-in
Uninterruptible Power Supply (UPS) and full PBX functions to meet different usage scenarios.

The UCS501 is equipped with up to 8 analog ports and 2 Ethernet interfaces for seamlessly integrating
VoIP trunks and your existing PSTN lines. In addition, UC501 supports a wide selection of codecs
and signaling protocols, including G711 (alaw/ulaw), G722, OPUS, AMR-NB/WB, SILK, G723.1
G726, G729, GSM, ADPCM, iLBC, H263, H263P, H264, VPS8. Taking full advantages of open
source platform, the UC Series appliances support industry standard SIP trunks, IAX2 trunks, analog
PSTN trunks, and analog station trunks. In addition, the UC501 is modular in design, equipped with
1FXO/1FXS/4FXO/4FXS modules, and with a detachable chassis, users can easily change the port
type or expand the system.

The UC series IPPBX delivers a multi-functional business office telephony system designed for
small to medium enterprises. The series integrates functions such as IP phone, fax, and voice
recording, and is compatible with multiple service platforms such as Cisco CallManager, Broadsoft,
Huawei IMS and Asterisk, and terminals. The products are highly reliable, easy to install and deploy,
and offer a brand-new experience in mobile offices and communications.

The UC series delivers a full-featured IP Telephony solution. By supporting intelligent
communication functions such as mobile phone extensions, instant multi-party conferences, call
history, click-to-dial, and customer information management, it not only facilitates seamless
communication between enterprise employees and customers, but also provides a solid basis for
enterprises to analyze core business data.

Specification
Table 1-1-1 Product Specification
Item Description
Up to 800 extension registers
System Capacity 100 concurrent calls with G.729 codec

300 concurrent calls with G.711 codec
Max Network Interface | 2x10/100M LAN port
Max FXS/FXO Interface | 8

USB Port 1xUSB 2.0 for external storage or disaster recovery system
External Storage 1xSD slot, support up to 128G

Telephony Interface FXS/FXO interface, Optional

RAM DDR3 1GB

Storage 16GB Onboard Flash
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‘ Power Consumption 12V/1.33A  16W Maximum

Features

General

Up to 8 FXS/FXO (PSTN/POTS) Analog Port

Support SIP & TAX2

Abundant HD voice codecs: OPUS, AMR-NB/WB, G.722, SILK and VP8
HD Video Calls

Echo Canceller

System

Simple and Convenient Configuration via Web GUI
User Portal

Extension User Privileges

System Administrators Monitor

Event Notification

Support Backup/Restore

Remote Management

Hot Standby

Network

OpenVox Communication Co. , LTD.

Network configuration

Support Static Route

Support Fail2ban

Secure SIP calling (TLS encryption)

Support Multiple VPN protocols including OpenVPN, L2TP, N2N, SSTP

Import/Export Extensions

Call Transfer

Follow-Me/Ring Group/Queue
Quickly Auto Provision IP Phones
Support IMS

Flexible Inbound/Outbound Route
Blacklist

AutoCLIP

Time Condition

PIN List

Automated Attendant (IVR)

12

URL: www.openvox.cn



OpenVox

UC501 User Manual

*  Phonebook

e LDAP Service

*  Wakeup Service

* DISA (Direct Inward System Access)

* Conference

e (Call Back

e Call Parking

* Paging and Intercom

e Speed Dial

e (Call Recording

*  Music On Hold

e Support Open API Protocol (based on Asterisk)
e Click2call

*  Support WebRTC

*  Access Control Interface based on ACL
e AITTS

*  SIP Instant Messaging

*  Voicemail

*  Missed Calls Notification
*  Email Server

*  Antispam support

*  Support Mail Relay

* Fax to Email

Report

* (all Detail Records (CDR)
* Billing Report

1.2 Compatible Endpoints

* Any SIP compatible IP Phone (Desktop Phones and Soft Phones for Windows, Linux, i0S
and also Android platforms). Desktop phone examples include: CooFone Series IP Phones
provided by OpenVox, and also Cisco, Grandstream, Yealink, Polycom, Snom, Akuvox,
Escene, Favil, HTek etc. Soft Phone examples include 3CX, CooCall, Linphone, X-Lite,
Zoiper etc.

* JAX compatible endpoints, for example, CooFone IP Phones provided by OpenVox and also
Zoiper softphone.

* Analog Phones and Fax Machines

*  Web Extensions (WebRTC)
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1.3 Module Combination

Users can choose two module accessories to customize.
e FXO-100+FXO-100
e FXO-100+FXS-100
e  FXO-100+FX0-400
e  FXO-100+FXS-400
e  FXS-100+FXS-100
e  FXS-100+FXO0-400
e FXS-100+FXS-400
e  FXO0O-400+FX0-400
e  FXO-400+FXS-400
e FXS-400+FXS-400

1.4 Log in to the Web GUI

e Stepl
Use a CATS5 cable to connect the device to the local network where the PC is connected, or
connect the device directly to the PC.

e Step2
Dial “**89” to obtain device IP address by an analog telephone, the device defaults to a fixed IP
address: 172.16.101.1

e Step3

Make sure that the PC and the device are on the same network segment.
e Step4

Enter the device IP address in the browser address bar (e.g. 192.168.2.218);
e Step5

You can enter the login interface for device configuration by selecting your role and entering a
password on the login interface. The default administrator password is admin.

Getting Started!

Website Login
Default IP:; 172.16.101.1
Username: admin

Password: admin

14
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PBX Management

Figure 1-3-1 Login interface

1.5 Web GUI overview

The web management interface of the UC series includes three areas: System button area, Menu bar,

and Configuration area.

Figure 1-4-1 Web GUI layout

(1) .

(3)

Table 1-4-1 Web Management Interface Layout

Item

Description

(1) System button area

Contains buttons such as Reboot, Logout. Product information; and displays the
identity of the current login user.

(2) Menu bar

Displays submenus for your selection when the mouse pointer is moved onto a

menu. The selection result is displayed in the configuration area.

(3) Configuration area

View or modify configuration.

OpenVox Communication Co. , LTD.
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2 System

2.1 Dashboard

The option "Dashboard" of menu "System" in UC series is a visualization tool that shows a general
view of the system and gives a faster access to administrative actions in order to allow the user an
easy administration of the server such as "System Resources", "Processes Status", "Hard Drives".
Below a short description of each one.

System Resources: Here shows general information about the system where UC series is running. It
allows to check out the history of CPU and Memory usage over the time.

Figure 2-1-1 System Resource

System Resources

@ cru @ Memory

60 IDLE(%)
%5
» - * T — .
=
45
CPU
30
15 USED(%)
51
®
R g t———y ot ® ® — "
5:26:30 5:27:00 15:27:30 Memory

Processes Status: It shows the enabled and disabled processes. Here you can start, stop and restart
these processes.
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Figure 2-1-2 Processes Status

System Resources

@ cru @ “emory

60 IDLE(%%)
25
. » . ° . .
45 -
CPU
30
15 USED(%)

a1

.‘-"‘-h.._.__...-.-—-._.._--—. .-'—-."'-..._.__..-.-——-.

15:26:30 15:27:00 15:27:30 Memory

Hard Drives: Hard Drives shows the free and used space of the hard drives installed on your server.

Figure 2-1-3 Hard Drives

Local Storage USB/SD Storage

' Nat Inserted

@ Used Free @ Used Free
118 GB 726 GB — GB - GB

Communication Activity: This applet shows the number of extensions, trunks and calls currently on
sip server.
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Figure 2-1-4 Communication Activity

Communication Activity

'B PJSIP Devices

FXO Trunks

lE FX5 Devices VolIP Trunks

2.2 Network

2.2.1 Network Parameters

The option “Network Parameters” of the Menu “Network” in UC series series lets us view and
configure the network parameters of the server.
Navigate to System > Network > Network Parameters to set network parameters according to the

installed network environment.
Figure 2-1-5 Network Parameters Interface

Network Parameters
Basic
Basic Settings
Host
| localhost |
Work Mode
| Double L
Primary DNS
| 8888 8} |

Secondary DNS

| 114114 114.114 |
IP Configuration IP Configuration

| WAN | | LAN |
Type Type

| Static v | Static v
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This corresponds to the general network parameters of the server.

Table 2-1-1 Description of Edit Network Parameters

Item Description
Basic Settings
Host Server Name, for example: pbx.subdomain.com
Work Mode Optional work modes: Single/Double
Gateway IP Address of the Port of Connection (Default Gateway)
Primary DNS | IP Address of the Primary Domain Name Server (DNS)
Secondary DNS | IP Address of the Secondary or Alternative Domain Name Server (DNS)
IP Configuration
The type of IP address that the Interface has, which could be STATIC
Type when the IP address is fixed or DHCP when the IP address is obtained
automatically from a DHCP server.
IP Address IP Address assigned to the Interface
Mask The Network Mask assigned to the Interface
MAC Physical Address of the network Interface
Status Shows the physical status of the Interface, if it’s connected or not
2.2.2 VPN Client

The VPN Client module of the menu “Network™ lets us connect to the VPN Server.
Navigate to System > Network > VPN Client, chose client type and enter the Server IP Address,

switching the Enable to on and save changes. Then the Server will assign this client an IP address.

You are supposed to upload an OpenVPN Client config file downloaded from the VPN server if you

chose OpenVPN mode.

OpenVPN

Basic

OpenVPN Settings

Enable OpenVPN

Dizable
Type

Upload OpenVFPN Package
Config. File

FEEME | FEETRE

Connect Status: Disabled

OpenVox Communication Co. , LTD.

Figure 2-1-7 VPN Client Interface
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N2N

Basic

N2N VPN Settings

Enable

| Disable ¥

Server |P Address

Server Port

Local IP

Subnet Mask

Uzer Name

User Password

Connect Status: Disabled
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L2TP

Basic

L2TP VPN Settings

Enable

Disable v

Server IP Address

User Mame

User Password

|P=ec

NO L

Default Gateway

NG v

Connect Status: Disabled

2.2.3 Static Routes

The Static Routes module of the menu “Network™ lets users view and add the routing rules.
Figure 2-1-8 Static Routest Interface

Static Routes

Routing Table Static Routes
Destination Subnet Mask Gateway Metric Interface
0.0.00 0.0.00 172.16.0.1 1024 WAN
172.16.0.0 255.255.0.0 0.0.0.0 0 WAN
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Static Routes

Static Routes

Destination Subnet Mask Gateway Metric Interface Edit Delete

WAN v | # 1]

Table 2-1-2 Description of Static Routes

Item Description

Destination | ldentified the destination of IP packet.

Subnet Mask | Identified the segment where the destination host or router locates with destination.
Gateway Also named Next Hop Router, defined the next hop server the packets send to.

Used to make routing decisions, contains any number of values that help the router

Metric
determine the best route among multiple routes to a destination.
Interface The ethernet LAN/WAN intreface, denfined the interface used to send packet for
the specific destination.
2.2.4 DHCP Service
DHCP Server

DHCP (Dynamic Host Configuration Protocol) is a standardized network protocol used on Internet
Protocol (IP) networks for dynamically distributing network configuration parameters, such as IP
addresses for interfaces and services.

With DHCP, computers/IP phones request IP addresses and networking parameters automatically
from UC series WAN/LAN port which saves administrators a lot of time when compared with
having to configure these settings manually.

The option "DHCP Server" allows configuring UC series’s DHCP service so it can assign IP
addresses in the network.

Navigate to System > Network > DHCP Server:
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Figure 2-1-9 DHCP Server interface

DHCP Server

Status: Inactive

Starting IP

172 . 16 . 120 . 1
Address: *

Ending IP

172 . 16 . 120 . 6
Address: *

Lease Time: * 50000 | (Of 1 to 30000 Seconds)

DNS 1: . : : (Optional)
DNS 2: : : : (Optional)
WINS: . : : (Optional)

Gateway: . . . (Optional)

Here the description of each field.
Table 2-1-3 Description of DHCP Server

Item Description
Status It indicates if the DHCP service is enabled or disabled.
Starting IP Address| This will be the beginning of the IP range that the server will provide.

Ending IP Address | This will be the ending of the IP range that the server will provide.

Lease time Amount of time the IP address will be assigned to devices in the network.
DNS 1 This address is the Primary DNS that the server will provide.

DNS 2 This address is the Secondary DNS that the server will provide.

WINS It is the IP of the WINS Server that will be given to Windows machines.
Gateway This is the address the server will provide as Gateway.

To save changes just click on the button . The service can be started by clicking on

Enable DHCP

DHCP Client List

This module shows a list of DHCP clients and leased IP addresses.
Navigate to System > Network > DHCP Client List and you will see a list of all devices receiving
their IP address from the UC series system.
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Figure 2-1-10 DHCP Client List interface

DHCP Client List

IP Address MAC Address Active Action

172.16.120.5 a0:98:05:01:62:71 Mo View Details
172.16.120.2 a0:98:05:01:62:71 Mo View Details
172.16.120.4 da:06:8f73:25:27 No View Details
172.16.120.1 a0:98:05:01:65:.af Na View Details
172.16.120.6 00:02:15:16:17.88 Yes View Details
172.16.120.3 00:aa:bb:cc.dd.ee Yes View Details

To see the leased time of each address, click on "View Details".
Assign IP Address to Host

With this option you can assign an IP address to a specific device through MAC address. When the
device requests an IP address, the DHCP server will provide it according to the MAC address. All the
associations created by the user are shown in a list.
Navigate to System > Network > Assign IP Address to Host.

Figure 2-1-12 Assign IP Address to Host

Assign IP Address to Host

Assign IP Address =M conrch | Host Name v m

Host Name IP Address MAC Address

Mo records match the filter criteria

o ) Assign IP Address ) ) ) )
To create a new association, click button. Fill out the required information and

click on “ button.
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Figure 2-1-13 Add Assign IP Address
Assign IP Address to Host

Basic

Host Name *
IP Address™

MAC Address”

The following table shows the description of each field:

Table 2-1-4 Description of Assign IP Address

Item Description
Host Name | Name that you want to assign to the device
IP Address | IP Address you want to use for the device

MAC Address MAC number of the device

2.3 Security

2.3.1 Audit

The module "Audit" of the menu "Security" in UC series shows a list of all the users that have
logged in the system with the date, the username, the source IP address and other details. The results
can be filtered by date and string. The coincidences with the string will be highlighted in the results.
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Figure 2-1-14 Audit interface

Audit
Date M 4 Page [1 of 2
2019-05-06 ¥
Date Type User Message
May 06 MAVIGATION  admin User admin visited "Extras »> Wideo Conference” from 282.51.181.121.
12:21:52
May 06 LOGIN admin Web Interface login successful. Accepted password for admin from 183.215.194.135,
14:06:35
May 06 NAVIGATION  admin User admin visited "System >> Dashboard” from 183.215.194.135.
14:08:09
Tf?:?ig NAVIGATION admin | User admin visited "PBX >> Recording >> Calls Recordings” from 183.215.194.135.
:"1:‘4:'???3 MAVIGATION  admin User admin visited "System »> Dashboard" from 282.51.179.118.
May 06 LOGIN admin Web Interface login successful. Accepted password for admin from 172.16.8.250.
15:35:58
May 06 MAVIGATION  admin User admin visited "System »>> Network »> DHCP Service »>> DHCP Server®™ from 172.16.8.258.
15:36:16
May 06 LOGIN admin Web Interface login successful. Accepted password for admin from 172.16.8.258.
15:36:53

The results of the search can be downloaded in different formats such as PDF, XML and CSV by
clicking on the "Download" button.

2.3.2 Weak Keys

The module "Weak Keys" of the menu "Security" lets us identify the keys that are not enough strong
for the extensions created in UC series (SIP and IAX2). This module shows all the extensions but
you can filter the results by entering a specific extension number or part of it.
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Figure 2-1-15 Weak keys interface

Weak Keys

& Download | + Search Extension ¥ m

Extension Description Status
106 106 oK
107 107 oK
108 108 OK
109 109 OK
110 110 OK
105 105 oK
104 104 OK
103 103 oK
102 102 oK
101 101 oK

You can download the results in different formats such as PDF, XML and CSV by clicking on the
"Download" button.

Change Key

If the key of an extension is not enough strong, you will be notified through the Status column and a
link called "Change Secret" will be available to change the key. Once you click on this link, you will
see a form where you can set the new secret. The secret must be at minimum six characters in length
of which must contain at least two numbers and two letters. When the new secret is set, click on the
"Save" button to apply the changes.

2.3.3 Certifications

The module "Certifications" of the menu "Security" implement greatly enhances the security. It's also
rather confusing to get it working, and create or add a certificate on the asterisk server. There are
three Client Methods for us to choose, it configures the clients to use TLS.
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Figure 2-1-16 Certificate setting interface

Certifications

Server Key

Generate Server Key: Download

Server key already exist.(Click "Action” to override it)

Client Keys
Key Name IP Address Operation
108 172.16.8.22 Download
109 172.16.8.120 Download
110 172.16.8.120 Download
1234 172.16.8.87 Download

To use TLS, you need to understand the principle of it. Check the TLS configuration parameters
below, you would be rewarded about it.

We can create the certificate when inputted the Key Name, Organization, IP address and the
Password. After client and server mutual authentication, with a license, it can be allowed to access.
There are several basic steps we need to do:

1. Your asterisk server needs a certificate.

We must create or add a certificate on the asterisk server. Creating a server key - We need to create a
digital key for our server, and the key.pem is your server key. The key.pem file is your server key and
the request.pem is your certificate request.

2. Add some configuration settings into the sip.conf file.

3. Configure the clients to use TLS

2.3.4 Firewall

Firewall Rules

UC series system has been preconfigured with a built-in firewall which prevents your IP phone
system from unauthorized access, phone calls and other attacks. To manage the firewall, navigate to
web menu Security->Firewall.

The option "Firewall" of the menu "Security" in UC series allows building iptables rules to control
the packets that send and receive the UC series.
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Figure 2-1-18 Deactivate firewall rules

Firewall Rules

Activate FireWall

Order Traffic Target Interface Source Address Destination Address Protocol Details

@« & IN: ANY 0.0.0.00 0.0.0.00 ALL

To use this module the firewall must be enabled with the rules that appear by default. It can be done
by clicking on "Activate Firewall" button. Once the firewall is enabled, you can create, delete, edit,
disable and reorder the iptables rules.
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Figure 2-1-19 Firewall rules interface

Firewall Rules

Order Traffic Target Interface Source Address Destination Address Protocol Details EDIT

1 ,.j !‘C IN: ANY 0.0.0.0/0 0.0.0.0/0 ALL @

REORDER ACTIVATE
DEACTIVATE
Every time you create or edit the rules, you have to save the changes. You can do this by clicking on
"Save" button that will appear automatically when you modify something. If you don't save the
changes the rules won't take effect in the system.

Adding a New Rule

To add a new rule click on the button and a form will appear with some data to fill out.

The form can vary depending on the parameters you select for Traffic and Protocol.
Figure 2-1-20 Add a new rules interface

Basic

Basic
Traffic

INPUT v
Interface IN

ANY A
Source Address

0.0.0.0 s 24
Destination Address

0.0.0.0 24
PROTOCOL DETAILS

Protocol

ALL v

ACTION DETAIL

Target

ACCEPT v

The ports used when you select the protocol TCP, UDP, ICMP and IP, are obtained from the module
"Define Ports" in the same menu. Therefore, make sure the port you want to use is previously
defined if you want to create a new rule.

In the source and destination address fields you have to enter the IP with the format x.x.x.x/y,

where y is the network mask and should be a number between 0 and 32. If you let the default IP
address (0.0.0.0) the netmask will be 0. If you let the netmask in blank it will not be taken into
account. To enter a specific IP address, just let in blank the netmask value.

Once you created the rule, click on "Save" button and the new rule will appear in the list. Make sure
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you save the changes so they take effect in the system after creating a new rule.
Editing a Rule

To edit an existing rule, click on the blue notebook icon corresponding to the rule. Here you can
modify parameters of the rule.
Figure 2-1-21 Edit a rules interface

Firewall Rules m
Basic
Basic
raffic
INPUT v
Interface IN
ANY v
Source Address
0.0.0.0 s 0
Destination Address
0.0.0.0 s 0
PROTOCOL DETAILS
Protocol
ALL v
ACTION DETAIL
Target
ACCEPT v
.
Deleting a Rule

To delete a rule just select the checkbox corresponding to the rule at the left side and click on
"Delete" button. Make sure you save the changes so they take effect in the system after deleting a
rule.

Reordering the Rules

You can modify the order of the rules by clicking on the blue arrows in the column Order. If you
click on the up arrow of a rule, this rule will go up one position and the one which was in that
position will go down. If you click on the down arrow of a rule, this rule will go down one position
and the one which was in that position will go up. Make sure you save the changes so they take
effect in the system after modifying the position of the rules.

Activate /Deactivate a rule

You can activate or deactivate a rule by clicking on the light bulb corresponding to the rule. When it
is ON the rule is activated, when it is OFF the rule is deactivated. Make sure you save the changes so
they take effect in the system after doing this action.
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Define Ports

The module "Define Ports" of the menu "Security" in UC series allows creating, editing, and deleting
ports that are used for the module "Firewall Rules". These ports can be from the protocols TCP, UDP,
ICMP and IP. This module shows a list of all the existing ports and the results can be filtered by
name and protocol.

Figure 2-1-22 Define Ports interface

Define Ports
Search| Name v
Name Protocol Details Option
HTTP TCP Port 80 View
HTTPS TCP Port 443 View
POP3 TCP Port 110 View
IMAPS TCP Port 993 View
S55H TCP Port 13505 View
SMTP TCP Port 25 View
POP35 TCP Port 995 View
JABBER/XMPP TCP Port 5222 View
OpenFire TCP Port 9090 View
IMAP TCP Port 143 View
SIP UDP Ports 5004:5082 View
RTP UDP Ports 10000:20000 View
MGCP UDP Port 2727 View
1AX2 UDP Port 4569 View
14X1 UDF Port 5036 View
DNS UDP Port 53 View
TFTP UDP Port 69 View
DHCPD UDP Ports 67:68 View
Define Port

To define a new port, click on the button and a form will appear with some

parameters to fill out. The form can vary depending on the parameters you select for the field
Protocol. Once the information is filled, click on "Save" button.

32
OpenVox Communication Co. , LTD. URL: www.openvox.cn



OpenVox

UC501 User Manual

Define Ports m

Basic

Name *

Protocol®

Type
Code
Protocol Number

Comment

View Port

To view an existing port, click on the "View" link located in the row corresponding to the port. Here
you can see the information of the port and edit it if needed.

Basic

Name

HTTFP

Protocol TCP

Port

20

Type

Code

Protocol Number

Comment

30
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Edit Port

To edit a port, click on the "View" link corresponding to the port you want to modify and then click

on "Edit" button. A form will appear with the parameters of the port ready to be modified.

Define Ports m

Basic

Name *

HTTP

Protocol*

TCP v

Port*
30

ype
Code
Protocol Number

Comment

20

Delete a port

To delete a port just select the checkbox located at the left side corresponding to the port and click on
"Delete" button.

2.3.5 Fail2Ban

Fail2ban scans log files (e.g. /var/log/apache/error log) and bans IPs that show the malicious signs --
too many password failures, seeking for exploits, etc. Generally Fail2Ban is then used to update
firewall rules to reject the IP addresses for a specified amount of time, although any arbitrary other
action (e.g. sending an email) could also be configured. Out of the box Fail2Ban comes with filters
for various services (apache, courier, ssh, etc).

Fail2Ban is able to reduce the rate of incorrect authentications attempts however it cannot eliminate
the risk that weak authentication presents. Configure services to use only two factor or public/private
authentication mechanisms if you really want to protect services.

The option "Fail2Ban" allows configuring Fail2ban service so it can prevent the uc series from
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malicious attacks.
Navigate to System > Security > Fail2Ban to configure rules.
Figure 2-1-23 Fail2Ban interface

Fail2Ban

Settings Add whitelist Whitelist Blacklist

Max Retry

10 [

Find Time

600

Ban Time

3600

1AX2
Max Retry

10

Find Time
G600
Ban Time

3600

HTTPS
Max Retry
5
Find Time

600

Ban Time

“Max Retry” limits the authentication attempts. “Find Time” defines the time duration from the first
attempt to the last attempt which reaches the “Max Retry” limitation. “Ban Time” is the time in
seconds the IPPBX system will block the IP which exceeds max retry. These settings don’t take
effect on any allowed addresses.
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Fail2Ban
Settings Add whitelist
Protocol
OFF SIP
IP
Netmask
Awailability OFF

Figure 2-1-24 Fail2Ban add whitelist

Whitelist Blacklist

OFF IAX2

OFF

HTTPS

OFF  SSH

Add whitelist allows you to add a trusted IP addresses or network addresses to the system IP
whitelist. The IPs in the whitelist will always be treated as trusted IP’s and will not be filtered by the

firewall rules.

2.4 User Permis

sion

System > Users Permission allows you to create users and modify the permissions of users
accessing the web interface. If the selected user group is Administrator, all function permissions are
enabled by default; or the user group is set to Custom, and the user web permissions are customized.
Click the "Create" button to create a new user, fill in the necessary information, and click Save:
Figure 2-1-26 Create New User

User Permission

User 101~ G

System

Dashboard

Network

Security

User Permission

Storage

Email

LDAP Server

OpenVox Communication Co

roup Custom

Metwork Parameters
L2TP

Audit

Hot Standby

Fail2Ban

Storage Devices

., LTD.

Extras

OpenVPN
Static Routes
Weak Keys

Firewall Rules

Auto Clean Up

o | omet

N2N

Certifications

Define Ports
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2.5.1 Storage Devices

The option "Storage™ of the menu "Storage" allows you to format your TF/SD card and set the
default storage device.

Figure 2-1-30 Storage Devices Interface

Storage Devices

Basic Recording Backup
(@) Local Disk (6969M Bytes Free) Select Device

O The partition's filesystem must be ext4

2.5.2 Auto Clean Up

The option "Auto Clean Up" of the menu "Storage" allows you to configure the clean-up frequency.

Figure 2-1-31 Auto Clean Up Interface

Auto Clean Up m

Basic

Drop the recorded file in time

30 days (One month) r

Drop the recorded file in system available space

10% v
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2.6 Email

The module Email allows adding a SMTP Server generally used to send messages from a mail client
of a different mail server.
The fields to configure an Email are:

Figure 2-3-7 Email

Email E

Basic Voicemail Template Faxmail Template
Status OFF
SMTP Server
GMAIL v
Domain®

smip.gmail.com

Port™
hav
Username™
Password *
TLS Enable OFF  This option allows the authentication with certificates.
Table2-3-2 Definition of Email
Item Definition
Status Status of connection SMTP Server.
SMTP Server Remote email server.
Domain Domain of SMTP Server.
Port Port to establish the connection with SMTP Server.
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User Username of email account from SMTP Server.
Password Password of email account from SMTP Server
TLS Enable To enable certificates of TLS (Transport Layer Security). Some SMTP
servers like Gmail requires these certificates.
2.7 LDAP Service

LDAP (Lightweight Directory Access Protocol) is a protocol for accessing directory services. It is
generally used as a phone book on IPPBX. Based on the available LDAP services, it meets the
requirements for fast search of phone directories. You can set up UC IPPBX as a server.

Once LDAP is set up, you can search the LDAP directory and find contacts on your IP phone.

LDAP Server

Figure 2-3-7 LDAP Service

LDAP Settings Phone Book nodes

Enable LDAP Server

Domain Component First

phx

Domain Component Second

com

Organizational Unit

phx

Common Name

admin

Password

OFF

OpenVox Communication Co. , LTD.
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2.8 Maintenance

2.8.1 Firmware Update

The option "Firmware Update" of the menu "Maintenance™ allows you to update the firmware
version by uploading firmware file you download from the official website as well as update
firmware online.

Figure 2-1-32 Firmware Update

Firmware Update

Basic

System Version: 3.2.5 Build 1904

Choose a File:

2.8.2 Backup & Restore

The option "Backup & Restore " of the menu "Maintenance" allows you to back up and restore the
configuration of UC series, besides, you can also reset device to the default settings. If you have
made a backup any time before this will appear in the list. To download a backup from the list, just
click on the name of the tar file.

Figure 2-1-33 Backup & Restore

Backup & Restore

Basic Auto Backup

Current Version:2.2.5 Backup

Choose a file: Restore

Reset to default settings

© Device will reboot automatically once restore finished.
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To enable auto backup, navigate to System > Maintenance > Backup & Restore > Auto Backup,
change the disable option to the frequency you want . There are three media you could select to back
up your config file : SD Card, FTP and CIFS.

Basic Auto Backup

Auto Backup

Disable A
Media
‘ FTP v

SD Card
CIFS

Port

User Name
Password

Save Path of Server

Local Files FTP Server Files

2.8.3 Login Settings

The option “Login Settings” of the Menu “Maintenance” in UC series lets us configure the login
settings.
Navigate to System > Maintenance > Login Settings to setup the login mode and port.
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Figure 2-1-35 Login Settings Interface
Login Settings

Web S§SH

Mode

https v

HTTP Port

a0

HTTPS Port

443

User Login Timeout

15 v

By default, the SSH port is 13505. Generally, it is recommended that the SSH be disabled.
To enable SSH, enter the developer mode, navigate to System > Maintenance > Login Settings >
SSH Settings, switching the enable to the on.

Figure 2-1-36 SSH Settings interface

Login Settings

Web SSH

Enabled

On Y

Password
admin
Port

13505

2.8.4 Reboot Settings

This option allows for the rebooting of the IP-PBX series. Upon choosing whichever of the two
options, you will be prompted to confirm the action.
Navigate to System > Maintenance > Reboot Settings.

42
OpenVox Communication Co. , LTD. URL: www.openvox.cn



omr'VOX_ UC501 User Manual

Figure 2-1-34 Reboot Settings Interface

Reboot Settings

Basic

Reboot Setting Enable OFF
Reboot Type
Weekly r

Week

Sunday T

Hour

13 v

Minute

2.9 Event Center

The UC system provides time monitoring and prompting functions. Users can set events and
notifications that need to be monitored, and add notification contacts. You can send monitoring alerts
by sending emails or dialing extensions.

2.9.1 Event Settings

Event Settings Notification Contacts

Name Record Maotification Edit Notification
Operation

Modify Administrator Password ON ON
User Login Success ON ON
User Login Failed
User Logout ON ON
Extension User Password Changed
Telephony

Outgoing Call through Trunk Failed ON ON
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Edit Contact

Select Contact:
User Mame:
Method:

Email:

stom ¥

[JSend Email

[CIDial Exten

2.9.2 Event Logs

In the upper right corner of the notification bar and Event Center > Event Log page, you can view

the relevant logs of monitoring events.

Event Logs

& Download | v

Date

2019-05-06 15:26:02

2019-05-06 15:24:35

2019-05-05 15:46:08

2019-04-30 17:31:27

3019-04-30 17:15:40

2019-04-30 15:50:20

2019-04-20 15:58:52

2019-04-30 15:51:48

2019-04-30 10:43:06

3019-04-30 10:42:03

2019-04-29 15:51:06

2019-04-29 15:38:11

Event Type: | All

Event Type
Operation
Operation
Operation
Operation
Operation
Telephony
Operation
Operation
Telephony
Telephony
Telephony

Operation

2.10 Tool Kit

2.10.1 Network Capture

¥ | Event Name:

Event Name
User Login Success

User Login Failed

User Logout

User Logout

User Login Success

VoIP Trunk Registration Failed
User Login Success

User Login Success

VoIP Trunk Registration Failed
VoIP Trunk Re-registered

VoIP Trunk Registration Failed

User Logout

A

Start Date: End Date:

Contents

User login Success. UserName: admin; |P Address: 172.16.8.250.

User Login Failed. Username: admin; IP Address: 172.16.8.250.

The user logout. Usemame: admin; IP address: 172.16.8.250. Please check whether it is the normal operation
The user logout. Username: admin; IP address: 172.16.8.87. Please check whether itis the normal operation o
User login Success. UserName: admin; |P Address: 172.16.2.87

SIP trunk 172.16.249.11 registration failed. Hostname: invalid

User login Success. UserName: admin; IP Address: 172.16.8.250.

User login Success. UserName: admin; IP Address: 172.16.8.250.

SIP trunk 172.16.249 11 registration failed. Hostname: invalid

SIP trunk 172.16.249.11 has successfully registered. Hostname: invalid

SIP trunk 172.16.249 11 registration failed. Hostname: invalid

‘The user logout. Usemame: admin; IP address: 172.16.8.87. Please check whether it is the normal operation o

Page [T of 10N

The UC series have been supplied a network packets capture in the web for ease of user to analysis,

OpenVox Communication Co. , LTD.
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capture and monitor the network status, RTP flows, protocol analysis and so on.
Figure 2-1-37 Capture interface

Network Capture m

Basic

Interface Type @ Eth0 () Eth1 () Any

Source Host

Destination host

Port
Protocol @ ALLO) TcP () upP (D) RTP(D) RTCP () IcMP () ARP () SIP
2.10.2 Port Monitor

The UC series also supplied port monitor module for user to monitor and record the port steam.
Figure 2-1-38 Port Monitor interface

Basic

Port

Port 1 (FX3) ¥

Confirmation

00:01

The maximum duration of this recording is 10 minutes,and the
system will stop and download the recording file automatically when

time is up
Stop & Download
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2.10.3 IP Ping and Traceroute

The IP Ping and Traceroute module assist user to check the network connectivity.
Figure 2-1-39 IP Ping and Traceroute interface

IP Ping and Traceroute

Basic

www.google.com

www.google.com Traceroute

2.11 Preference

2.11.1 Language

The option “Language” of the Menu “Preferences” in UC series lets us configure the language for
the UC series Web Interface.
Select the language from the list and click on the “save” button.
You can also download or upload languages you need.
Figure 2-1-40 Language setting

Language
Basic
Select language | English v
CN
Cownload Language
Delete Language

Upload Language Upload
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2.11.2 Date/Time

The option “Date/Time” of the Menu “Preferences” in UC series lets us configure the Date, Hour and
Timezone for the UC series Web Interface.

Select the new date, hour and timezone and click on the “Apply changes” button.

Navigate to System > Preferences > Date/Time to deploy time server.
Figure 2-1-41 Date/Time Interface

Date/Time

System Time Sync time with NTP Server Sync time with Client

Current Date and time: 2019/5/6 T34:21:24
Mew Date
06 May 2018
Mew Time (16 » || 21 v || 22 *
Mew Timezone

AsialShanghai r

2.11.3 Currency

The option "Currency" of the menu "Preferences" lets us change the currency for Reports in UC
series Web Interface.

Select a currency from the available options and click on the “ button.
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Figure 2-1-42 Currency Setting interface

Currency

Basic

Currency

% - Dollar/Peso

ARE - Argentinian peso

B - Thai Baht / balboa panamefio
Es - Bolivar venezolano

Bs.F. - Bolivar fuerte venezolana
¢ - Salvadorean Colon

d - Vietnamese Dong

ECS - Dolar del Caribe Oriental
Kr - Corona danesa, corona sueca
£ - Lira

LS - Lempira hondurefio

(- Quetzal guatemalteco
£-Euro

£GBP - Great British Pound

R - South African Rand

Rp - Indonesian Ruppiah

Fs - Rupee

RS - Real brasilefio

pyd - Russian Ruble

A% - Australian Dollar

$ - Dollar/Peso
%-Yen -

% - Nicaraguan Cordoba/Canadian Dollar

2.11.4 About

Navigate to System >About, lets us view some information of UC series about firmware version and

other useful information.

About

Firmware Version:
Model Name:
FXO:

FXS:

Serial Number:
Firmware Build:

Hardware Version:

System Kernel Build Time:

Contact Address:
Tel:

Fax:

Email:

Web Site:

Figure 2-1-43 About information

255
UC300-A14EM2

4

1

a0980502064b

1811

14
2018-Nov-6-15:38:30
Address:10/F, Building 6-A, Baoneng Science and Technology Industrial Park, Longhua New District, Shenzhen, Guangdong,China 518109
0755 - 82535461
86-755-83823074
support@openvox.cn

hitp:/fwrww.openvox.cn/
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2.11.5 Develop Mode

You can enter the developer mode by clicking the Hardware Version 5 times. This process is
irreversible so please be cautious.

Developer Mode Options =

Are you sure you are entering developer mode? Please contact our customer service staff if you have any questions

Developer Mode: m
=
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3 PBX

The Menu “PBX” lets us configure extensions, trunks, routes, dialplan, queues, IVR and so on for
UC series.
In this menu, we can observe that we have different options for configuration.

3.1 Extensions

3.1.1 Extensions

The Extensions Module is used to set up each extension on your system. In the Extensions module,
you will set up the extension number, the name of the extension, the password, voicemail settings for
the extension, and other options.

Normally, each physical phone will be assigned to one extension. If you have a phone that has more

than one "line" button, you would normally make each line button register to the same extension

number, and then use the line buttons to manage multiple calls to and from the same line. However,

you could also create two or more extensions and assign each extension to a different line button.
Figure 2-2-1 Add an Extension interface

Extensions
s i o]
Port Type Password

Mame / Extension
101 101 - PJSIP sxraase

102 102 - PJSIP
103 103 - PJSIP
104 104 - pJSIP
105 105 - PJSIP
106 106 - PJSIP
107 107 - PJSIP
108 108 - PJSIP
109 109 - pJSIP

110 110 - pJsIp rrxanes

Click one of extensions number and edit it;
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Extensions

User Extension

Display Name

Figure 2-2-2 Extension parameter interface

Registration Password

z0etk5iY YgT2zKWmiRZ

Email Address

Mobile Number

User Password

ltem

Extension

Display Name

Secret

Dtmfmode

Canreinvite

Context

Host

Trustrpid

Sendrpid

Prack

Table 2-2-1 Definition of Extension parameter

Description
Basic
The extension number to dial to reach this user.

The CallerID name for calls from this user will be set to this name. only enter the name , NOT the
number.

Password (secret) configured for the device. Should be alphanumeric with at least 2 letters and
numbers to keep secure.

Advanced
The DTMF signaling mode used by this device, usually rfc2833 for most phone.
Re-Invite policy for this device, see Asterisk documentation for details.
Asterisk context this device will send calls to. Only change this is you know what you are doing.
Host settings for this device, almost always dynamic for endpoint.

Whether Asterisk should trust the RPID settings from this device. Usually should be yes for
CONNECTEDLINE() functionality to work if supported by the endpoint.

Whether Asterisk should send RPID (or PAI) info to the device. Usually should be enabled to the
settings used by your device for CONNECTEDLINE( ) functionality to work if supported by the
endpoint.

The PRACK request plays the same role as ACK, but for provisional responses.
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Type

NAT

Port

Qualify

Qualifyfreq

Transport

Avpf

Icesupport

Dtlsenable
Dtlsverify
Dtlssetup
Dtlscertfile

Dtlscafile

Dtlsprivatekey

Encryption

Callgroup

Pickupgroup

OpenVox Communication Co. , LTD.

Asterisk connection type, usually friend for endpoint.

NAT seting, see Asterisk documentation for details. Yes usually works for both internal and
external devices. Set to No if the device will always be internal.

Endpoint port number to use, usually 5060. Some 2 ports devices such as ATA may used 5061 for
the second port.

Setting to yes (equivalent to 2000 msec) will send an OPTIONS packet to the endpoint periodically
(default every minute). Used to monitor the health of the endpoint. If delays are longer then the
quality time, the endpoint will be taken offline and considered unreachable. Can be set to a value
which is the msec threshold. Setting to no will turn this off. Can also be helpful to keep NAT
pinholes open.

Frequency in seconds to send qualify messages to the endpoint.

This sets the allowed transport settings for this device and the default (Primary) transport for
outgoing. The default transport is only used for outbound message until a registration takes place.
During the peer registration the transport type may change to another supported type if the peer
requests so. In most common cases, this does not have to be changed as most devices register in
conjunction with the host=dynamic setting. If you are using TCP and/or TLS you need to make sure
the general SIP Settings are configured for the system to operate in those modes and for TLS,
proper certificates have been generated and configured. If you are using websockets (such as
WebRTC) then you must select an option that includes WS.

Whether to Enable AVPF. Defaults to no. the WebRTC standard has selected AVPF as the audio
video profile to use for media streams. This is not the default profile in use by Asterisk. As a result
the following must enabled to use WebRTC.

Whether to enable ICE support. Defaults to no. ICE ( Interactive Connectivity Establishment) is a
protocol for network address Translator (NAT) traversal for UDP-based multimedia sessions
established with the offer/answer model. This option is commonly enabled in WebRTC setups.

Whether to enable DTLS for this peer. Defaults to no.

Whether to verify that the provided peer certificate is valid. Defaults to no.
Behavior on DTLS incoming and outgoing connections, defaults to actpass.
Path to certificate file to present.

Path to cafile file to present

Path to private key for certificate file.

Whether to offer SPTR encrypted media (and only SRTP encrypted media) on outgoing calls to a
peer. Calls will fail with HANGUPCAUSE=58 if the peer does not support SRTP. Defaults to no.

Callgroup(s) that this device is part of, can be or more callgroups, e.g. ‘1,3-5’ would be in groups
1,3,4,5.

Pickupgroup(s) that this device can pickup calls from, can be one or more groups, e.g. ‘1.3-5
would be in groups 1,3,4,5. Device does not have to be in a group to be able to pickup calls from
that group.
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Allow specified codecs, the available codecs are on the left options bar and the selected on the
right.

Allow

Dial How to dial device, this should not be changed unless you know what you are doing.
Accountcode |Accountcode for this device.
Mailbox Mailbox for this device. This should not be changed unless you know what you are doing.

Asterisk dialplan extension to reach voicemail for this device. Some devices use this to
auto-program the voicemail button on the endpoint. If left blank, the default vmexten setting is

Vmexten . . . . . .
automatically configured by the voicemail module. Only changed this on devices that may have
special needs.

Deny IP Address range to deny access to, in the form of network/netmask.

IP Address range to allow access to, in the form of network/netmask. This can be a very useful
Permit security option when dealing with remote extensions that are at a known location (such as a branch
office) or with a known ISP range for some home office situations.

Email Address | The email address that completed dictations are sent to.

Language

Cod This will cause all messages and voice prompts to use the selected language if installed.
oae

The CID Number to use for internal calls, if different from the extension number. This is used to

CID Num | masquerade as a different user. A common example is a team of support people who would like

Alias their internal CallerID to display the general support number(a ringgroup or queue). There will be
no effect on external calls.

If you want to support direct sip dialing of users internally or through anonymous sip calls, you can

SIP Alias . . .. .
supply a friendly name that can be used in a addition to the users extension to call them.
Features
Override the callerid when dialing out a trunk. Any setting here will override the common
Outbound outbound callerid set in the trunk admin.
CID Format: “caller name” <#######>

Leave this filed blank to disable the outbound callerid feature for this user.

Cryptic Asterisk Dial Options, check to customize for this extension or un-check to use system
defaults set in Advanced Options. These will not apply to trunk options which are configured with
the trunk.

Asterisk Dial
Options

Number of seconds to ring prior to going to voicemail. Default will use the value set in Advanced

Ring Time . . - . L .
& Settings. If no voicemail is configured this will be ignored.

Number of seconds to ring during a Call Forward Busy or Call Forward Unavailable call prior to
Call Forward | continuing to voicemail or specified destination. Setting to Always will not return, it will just
Ring Time continue to ring. Default will use the current Ring Time. If voicemail is disabled and there is not
destination specified, it will be forced into Always mode.

Outbound Maximum number of outbound simultaneous calls that an extension can make. This is also very
Concurrency |useful as a Security Protection against a system that has been compromised. It will limit the number
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Limit

Call Waiting

Internal Auto
Answer

Call

Screening

Pinless
Dialing

Emergency
CID

Queue  State
Detection

DID

Description

Add Inbound
DID

Add Inbound
CID

Inbound
External Calls

Outbound

of simultaneous calls that can be made on the compromised extension.
Set the initial/current Call Waiting state for this user’s extension

When set to Intercom, calls to this extension/user from other internal users act as if they were
intercom calls meaning they will be auto-answered if the endpoint supports this feature and the
system is configured to operate in this mode. All the normal white list and black list settings will be
honored if they are set. External calls will still ring as normal, as will certain other circumstances
such as blind transfers and when a Follow Me is configured and enabled. If Disabled, the phone
rings as a normal phone.

Call Screening requires external callers to say their name, which will be played back to the user and
allow the user to accept or reject the call. Screening with memory only verifies a caller for their
callerid once. Screening without memory always required a caller to say their name. Either mode
will always announce the caller based on the last introduction saved with that callerID. If any user
on the system uses the memory option, when that user is called, the caller will be required to
re-introduce themselves and all users on the system will have that new introduction associated with
the caller’s CallerID.

Enabling Pinless Dialing will allow this extension to bypass any pin codes normally required on
outbound calls.

This callerid will always be set when dialing out an Outbound Route flagged ad Emergency. The
Emergency CID overrides all other CallerID settings.

If this extension is part of a Queue will attempt to use the user’s extension state or device state
information when determining if this queue member should be called. In some uncommon
situations such as a Follow-Me with no physical device, or some virtual extension scenarios, the
state information will indicate that this member is not available when they are. Setting this to
‘Ignore-State’ will make the Queue ignore all state information thus always trying to contact this
member. Certain side affects can occur when this route is taken due to the nature of how Queues
handle Local channels, such as subsequent transfers will continue to show the member as busy until
the original call is terminated. In most cases, this SHOULD BE set to ‘Use State’.

A description for this DID, such as “Fax”.
A direct DID that is associated with this extension. The DID should be in the same format as

provider (e.g. full number, 4digits for 10x4, etc).

Add a CID for more specific DID+CID routing. A DID must be specified in the above Add DID
box. In addition to standard dial sequences, you can also put Private, Blocked, Unknown,
Restricted, Anonymous and Unavailable in order to catch these special cases if the Telco transmits
them.

Recording
Recording of inbound calls from external sources.

Recording of outbound calls from external sources.
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External Calls

Inbound
Internal Calls

Outbound
Internal Calls

On Demand
Recording

Record
Priority Policy

Status

Voicemail
Password

Email Address

Pager Email
Address

Email
Attachment

Play CID

Play Envelope

Delete
Voicemail

VM Options

VM Context

VmX
Locater™

Recording of calls received from other extensions on the system.

Recording of calls made to other extensions on the system.

Enable or disable the ability to do on demand (one-touch) recording. The overall calling policy
rules still apply and if calls are already being recorded they can not be paused.

Call recording policy priority relative to other extensions when there is a conflict between an
extension wanting recording and the other not wanting it. The higher of the two determines the
policy, on a tie the global policy (caller or callee) determines the policy.

Voicemail
Enable or disable the voicemail function.

This is the password used to access the Voicemail system.

This password can only contain numbers.

A user can change the password you enter here after logging into the Voicemail system (*98) with
a phone.

The email address that Voicemails are sent to.

Page/mobile email address that short VVoicemail notifications are sent to.

Option to attach Voicemail to email.

Read back caller’s telephone number prior to playing the incoming message, and just after
announcing the date and time the message was left.

Envelope controls whether or not the Voicemail system will play the message envelope (date/time)
before playing the voicemail message. This setting does not affect the operation of the envelope
option in the advanced voicemail menu.

If set to “yes” the message will be delete from the voicemailbox (after having been emailed).
Provides functionality that allows a user to receive their voicemail via email alone, rather than
extension handset. CAUTION: must have attach voicemail to email set to yes otherwise your
messages will be lost forever.

Separate options with pipe(|)
le: review=yes|maxmessage=60

This is the voicemail context which is normally set to default. Do not change unless you understand
the implications.

Routing
Enable/ disable the VmX locater feature for this user. When enabled all settings are controlled by

the user in the user portal (ARI). Disabling will not delete any existing user settings but will disable
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Use When

Voicemail
Instructions

Press 0

Press 1

Press 2

No Answer

CID Prefix

Busy

CID Prefix

Not
Reachable

CID Prefix

access to the feature.

Menu options below are available during your personal voicemail greeting playback.
Check both to use at all times.

Uncheck to play a deep after your personal voicemail greeting.

Pressing 0 during your personal voicemail greeting goes to the operator. Uncheck to enter another
destination here. This feature can be used while still disabling VmX to allow an alternative operator
extension without requiring the VmX feature for the user.

The remaining options can have internal extensions, ringgroups, queues and external numbers that
may be rung. It is often used to include your cell phone. You should run a test to make sure that the
number is functional any time a change is made so you don’t leave a caller stranded or receiving
invalid number messages.

Use any extensions, ringgroups, queues or external numbers.
Remember to re-record your personal voicemail greeting and include instructions. Run a test to
make sure that the number is functional.

Optional destination call is routed to when the call is not answered on an otherwise idle phone. If
the phone is use and the call is simply ignored, then the busy destination will be used.

Optional CID prefix to add before sending to this no answer destination.

Optional destination the call is route to when the phone is busy or the call is rejected the user. This
destination is also used on an unanswered call if the phone is in use and the user choose not pickup
the second call.

Optional CID prefix to add before sending to this busy destination.

Optional destination the call is routed when the phone is office, such as a softphone currently off or
a phone unplugged.

Optional CID prefix to add before sending to this not reachable destination.

The extension module allows you create extensions from a CSV file and download a CSV file with
all the extensions that are currently configured in UC series. This makes it easy the migration of data.

Liploa

d CSV File

W e W

Choose File | No file chosen
| i —— |

OpenVox Communication Co. , LTD.

56
URL: www.openvox.cn



OpenVox

UC501 User Manual

To download a CSV file with all the extensions created in UC series, click on the
button and save the file into your local hard drive.

To upload a CSV with the extensions you want to create, click on m button, select the
CSV file and click on "Upload CSV File" button.

Make sure the following indications are taken into account:

o Duplicated extensions are not allowed.

e The first line of the CSV file must contain the headers of the columns.

e The file must have at minimum four columns.

e This type of file can be created and opened with any text editor or spreadsheets such as Open
Office Calc, Excel, etc.

e The separator of the columns is the comma.

3.1.2 Ring Groups

A ring group is a group of extensions that will ring when there is an external incoming call. You can
even put your Mobile Phone number in the ring group if you want to. For the mobile phone to work,
you must have the appropriate route and trunk set up.
You may not want a ring group — it’s entirely up to you. If you don’t require a ring group, you may
ignore this section.
When there is an incoming call to the ring group, the phones nominated in the selected group will
ring. You may select different ring group for each of the incoming trunk or you may nominate the
same group for all the trunks, in which case you will only need to define only one ring group.
The ring group screen is illustrated below:

Figure 2-2-3 Ring groups interface

Ring Groups m

Basic Advanced

Group Description

default ring group

Ring Strategy
ringal v
Ring Time (max 300 sec)

10

Extension List

Default v | 101(101) v X +

Default v | 102 (102) ¥ x +
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Table 2-2-2 Definition of add Ring groups interface

Item

‘ Definition

Basic

Ring-Group Number

The number users will dial to ring extensions in this ring group

Group Description

Provide a descriptive title for this Ring Group.

Ring Strategy

Ringall : Ring all available channels until one answers (default)

Hunt: Take turns ringing each available extension

Memoryhunt: Ring first extension in the list, then ring the 1 st and 2 nd extension,
then ring 1 st and 2 nd and 3 rd extension in the list...etc.

*-prim: there mode act as described above. However, if the primary extension (first
in list) is occupied, the other extensions will not be rung. If the primary is FreePBX
CF unconditional, then all will be rung

First available: ring only the first available channel

Firstnotonphone: ring only the first channel which is not ofthook-ignored CW.

Ring Time (max 300

sec)

Time in seconds that the phones will ring. For all hunt style ring strategies, this is the
time for each iteration of phone(s) that are rung.

Extension List

List extensions to ring, one per line, or use the Extension Quick Pick below to insert
them here.

You can include an extension on a remote system, or an external number by
suffixing a number with a ‘#’. Ex:2448089# would dial 2448089 on the appropriate
trunk (see outbound routing)

Extension without a ‘#’ will not ring a user’s Follow-Me. To dial Follow-Me,
Queues and other numbers that are not extensions, put a ‘#’ at the end.

Advanced

Announcement

Message to be played to the caller before dialing this group.
To add additional recordings please use the “System Recordings” MENU to the left.

Play Music On Hold

If you select a music on hold class to play, instead of ‘Ring’, they will hear that

instead of Ringing while they waiting for someone to pick up.

CID Name Prefix

You can optionally prefix the callerid name when ringing extensions in this group,
ie: If you prefix with “Sales:”, a call from John Doe would display as “Sales: John

Doe” on the extensions that ring.

Alert Info

ALERT INFO can be used for distinctive ring with SIP devices.

Ignore CF Settings

When checked, agents who attempt to Call Forward will be ignored, this applies to
CF, CFU and CFB. Extensions entered with ‘#’ at the end, for example to access

the extension’s Follow-Me, might not honor this setting.

Enable Call Pickup

Checking this will allow calls to the ring group to be picked up with the directed call
pickup feature using the group number. When not checked, individual extensions
that are part of the group can still be picked up by doing a directed call picked to the
ringing extension, which works whether or not this is checked.

Skip Busy Agent

When checked, agents who are on an occupied phone will skipped as if the line were
returning busy. This means that call waiting or multi-line phones will not be
presented with the call and in the various hunt style ring strategies, the next agent

will be attempted.

OpenVox Communication Co. , LTD.

58
URL: www.openvox.cn



OpenVox

UC501 User Manual

Confirm Calls Enable this if you’re calling external numbers that need confirmation-eg, a mobile
phone may go to voicemail which will pick up the call. Enabling this requires the
remote side push 1 on their phone before the call is put through. This feature only
works with the ringall ring strategy.

Remote Announce Message to be played to the person RECEIVING the call, if ‘Confirm Calls’ is
enabled.

To add additional recordings use the “System Recordings” MENU to the left
Too-Late Announce Message to be played to the person RECEIVING the call, if the call has already been
accepted before they push 1.

To add additional recordings use the “System Recordings” MENU to the left

Mode Default: Transmits the Callers CID if allowed by the trunk.

Fixed CID Value: Always transmit the Fixed CID Value below.

Outside Calls Fixed CID Value: Transmit the Fixed CID Value below on calls will
continue to operate in default mode.

Use Dialed Number: Transmit the number that was dialed as the CID for calls
coming from outside. Internal extension to extension calls will continue to operate in
default mode. There must be a DID on the inbound route for this. This will be
BLOCKED on trunks that block foreign Caller ID

Force Dialed Number: Transmit the number that was dialed as the CID for calls

coming from outside. Internal extension to extension calls will be continue to
operate in default mode. There must be a DID on the inbound route for this. This
WILL be transmitted on trunks that block foreign CallerID

Fixed CID Value Fixed value to replace the CID with used with some of the modes above. Should be
in a format of digits only with an option of E164 format using a leading “+”.

Record Calls You can always record calls that come into ring group, never record them, or allow
the extension that answers to do on-demand recording. If recording is denied then

one-touch on demand recording will be blocked.

3.1.3 Follow Me

Follow Me (also known as Find Me / Follow Me or FMFM) allows you to redirect a call that is
placed to one of your extensions to another location. You can program the system to ring the
extension alone for a certain period of time, then ring some other destination(s), such as a mobile
phone or a related extension, and then go to the original extension's voicemail if the call is not
answered. Follow Me can also be used to divert calls to another extension without ringing the
primary extension.

Select the PBX -> PBX Configuration -> Follow Me.

You will be presented with the following screen:
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Follow Me
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Figure 2-2-4 Follow Me interface
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Table 2-2-3 Definition of Follow Me

Item ‘ Definition

Basic

Disable By default (not checked) any call to this extension will go to this Follow-Me instead,
including directory calls by name from [VRs. If checked, calls will go only to the
extension.

However, destinations that specify FollowMe will come here.

Checking this box is often used in conjunction with VmX Locater, where you want a
call to ring the extension, and then only if the caller chooses to find you do you want it
to come here.

Initial Ring Time This is the number of seconds to ring the primary extension prior to proceeding to the
follow-me list. The extension can also be included in the follow-me list. A 0 setting
will bypass this

Ring Strategy Ringallv2: ring Extension for duration set in Initial Ring Time, and then, while

continuing call to extension, ring Follow-Me List for duration set in Ring Time.
Ringall: ring Extension for duration set in Initial Ring Time, and then, terminate call
to extension, ring Follow-Me List for duration set in Ring Time.

Hunt: take turns ringing each available extension

Memoryhunt: ring first extension in the list, then ring the 1st and 2nd extension, then
ring 1st 2nd and 3rd extension in the list....etc.

*-prim: these mode act as described above. However, if the primary extension (first in
the list) is occupied, the other extensions will not be rung. If the primary is FreePBX
DND, it won’t be rung. If the primary is FreePBX CF unconditional, then all will be
rung

Firstavailable: ring only the first available channel

Firstavailable:: ring only the first channel which is not off hook-ignore CW

Ring Time (max 60 | Time in second that the phones will ring. For all hunt style ring strategies, this is the
sec) time for each iteration of phone(s) that are rung

Follow-Me List List extensions to ring, one per line, or use the Extension Quick Pick below.

You can include an extension on a remote system, or an external number by suffixing

a number with a pound (#). Ex:2448089# would dial 2448089 on the appropriate trunk
(see Outbound Routing) .

Announcement Message to be played to the caller before dialing this group.
To add additional recordings please use the “System Recordings” MENU to the left.

Play Music On Hold | If you select a Music on Hold class to play, instead of ‘Ring’, they will hear that
instead of Ringing while they are waiting for someone to pick up.

CID Name Prefix You can optionally prefix the Caller ID name when ringing extensions in this group.
Ie: if you prefix with “Sales:”, a call from John Doe would display as “Sales: John
Doe” on the extensions that ring

Alert Info You can optionally include an Alert Info which can create distinctive ring on SIP
phones.
Advanced
Confirm Calls Enable this if you’re calling external numbers that need confirmation, eg, a mobile
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phone may go to voicemail which pick up the call. Enabling this require the remote
side push 1 on their phone before the calls is put through. This feature only works with
the ringall/ringall-prim ring strategy.

Remote Announce

Message to be played to the person RECEIVING the call, if ‘Confirm Calls” is
enabled.
To add additional recordings use the ‘System Recordings” MENU to the left

Too-Late Announce

Message to be played to the person RECEIVING the call, if the call has already been
accepted before they push 1.
To add additional recordings use the ‘System Recordings” MENU to the left

Mode

Default: Transmits the Caller CID if allowed by the trunk.

Fixed CID Value: Always transmit the Fixed CID Value below.

Outside Calls Fixed CID Value: Transmit the Fixed CID Value below on calls will
continue to operate in default mode.

Use Dialed Number: Transmit the number that was dialed as the CID for calls
coming from outside. Internal extension to extension calls will continue to operate in
default mode. There must be a DID on the inbound route for this. This will be
BLOCKED on trunks that block foreign Caller ID

Force Dialed Number: Transmit the number that was dialed as the CID for calls
coming from outside. Internal extension to extension calls will be continue to operate
in default mode. There must be a DID on the inbound route for this. This WILL be
transmitted on trunks that block foreign CallerID

Fixed CID Value

Fixed value to replace the CID with used with some of the modes above. Should be in
a format of digits only with an option of E164 format using a leading “+”.

3.1.4 Endpoint Configurator

The "Endpoint Configurator" module enables automatic remote configuration of supported endpoints.
With this module, the UC series administrator can point supported endpoints to the UC series as their

telephony server.

Figure 2-2-6 Endpoint Configurator interface

Endpoint Configurator m
m (= | 4 (Shoing 130191 »
Order Status MAC Address Current IP Manufacturer Model Manual Extenstions Extenstions Status
1 00:1F.C1:1D:BC:53 172.16.1.85 Hanlong (not detected) ¥ F [ ]
2 L 0C:33:3E/1ED5:44 172.16.1.67 Fanvil X6 v F L]
3 i AD98:05:17:02.8E 172.16.1.161 OpenVox c401 v rd L]
4 00:A8:59:F5°E0-T9 172.16.1.209 VOPTech (not detected) ¥ Fd L]
5 00:A8:59:F7-3C:83 172.16.1.210 VOPTech (not detected) ¥ F L]
6 0C:33:3E11B:5B:EA 172.16.1.212 Fanvil X4 v F L]
00:0E:30:00.81:EA 172.16.1.69 VOFTech VI2007 v g L]
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Interface description

Main listing
This is the listing of all endpoints that have been detected or entered. Unlike the old implementation,
any endpoints detected or uploaded in past sessions will be kept and displayed until they are
explicitly erased. The main listing contains the following columns:

Table2-2-4 Description of Interface description
Item Description
Status This displays the status of the endpoint as one or more icons. The available
flags are as follows:

Scroll icon: the endpoint has not been scanned, but rather defined in an upload.

Disk icon: the endpoint configuration has been updated in the database but not
yet applied to its configuration files.

Person icon: the endpoint has at least one endpoint assigned.

MAC Address This is the main identifier for the endpoint. Configurations in the database and
uploaded files are considered to refer to the same endpoint if they reference the
same MAC address.

Current IP If the endpoint was detected through a scan, this field will show the IP at which
the endpoint was found. This field is a link to the HTTP configuration interface
(if supported) of the phone.

Manufacturer This displays the detected manufacturer of the endpoint.

Model This displays the detected model of the endpoint. Since automatic model
detection is not (yet) implemented for some manufacturers, this field allows the
user to correct the model via a drop-down list. Accurate model detection is
required for many other features (such as account assignment) to work.

Options This link displays a modal dialog on which common options for the endpoint
can be manually configured.

ﬂEndpoint scan toolbar button

This widget contains a textbox with a network/netmask definition, and a magnifying glass icon. By
default, the network definition will be filled with the network definition of the first ethernet interface
of the Elastix server. The user may correct this definition to restrict the scan, and then click on the
icon to start the scan. When scanning, the toolbar will change to a spinning icon and a Cancel button.
As endpoints are detected, they will be added to the main listing, along with their detected
manufacturer and model. The toolbar will revert to its default state when the scan is done, or if the
scan is aborted with the Cancel button.

mEndpoint configuration toolbar button

Clicking on this button will start applying the configuration for all selected endpoints (all endpoints
for which the checkbox is set). When applying the configuration, the toolbar will change to a
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progress bar. As endpoints are configured, the progress bar will update, and the toolbar will revert to
the default state when the configuration is done. During configuration, a log is generated, and can be
viewed by clicking on the Configuration Log toolbar button.

Log : .
Conflgu ration Log toolbar button

Clicking on this button will open a modal dialog in which a log of the last configuration run will be
shown. This is useful for diagnosing issues with the module failing to configure an endpoint.

W Delet . .
Remove configuration toolbar button

Clicking on this button will (after a confirmation dialog) remove the database records for the selected
endpoints, as well as any generated configuration files for these endpoints. It will NOT, however,
contact the endpoints themselves in any way.

= CSV (Legacy)
) XML

= CSV (nested)
Download toolbar button

Clicking on this button will display a list of links to download the list of endpoints stored on the
database, in three different formats. The supported formats are:

e CSV (Legacy). This is the format used by the old Endpoint Configurator.

o XML. This format allows the definition of endpoints with multiple accounts and properties, as
an XML document.

e CSV (Nested). This format can be generated by careful editing in a spreadsheet, and uses
indentation to group multiple accounts and properties per endpoint.

ENN [T =

l Choose File | Mo file chosen
Upload toolbar button

Clicking on this icon will display a small dialog in which the user may specify an endpoint list file to
upload to the server. The file format is automatically detected.

3.2 Trunks

The "Trunks Module" is used to connect your FreePBX/Asterisk system to another VOIP system or
VOIP device so that you can send calls out to and receive calls in from that system/device. You can
create connections with Internet Telephone Service Providers ("ITSPs"), with other FreePBX/
Asterisk systems, with commercial VOIP phone systems, with FXO Gateways (a device that
connects an ordinary telephone line with a VOIP phone system using a network connection), and
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with FXO cards (cards that are installed in your computer and allow you to connect a standard

telephone line).

If you don't have a Trunk set-up, you can still make calls, but only to other extensions on your same

phone system.

Trunks

(] Trunk Name Type
O isp PJSIP
(] fxo FXO
Trunks
Basic Codec Advanced
Enable Trunk
on
Trunk Mode

IP Authentication

Authentication
Both

Trunk Name*

Host*

Username

Secret

Type

friend
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Figure 2-2-7 Add trunk interface
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Table2-2-5 Definition of add a SIP trunk

Item ‘ Definition
Basic
Enable Trunk Check this to disable this trunk in all routes where it is used.
Trunk Mode Authentication mode of this trunk.
Trunk Name Descriptive Name for this trunk.
Outbound Example: proxy.provider.domain:port

Proxy Server

Host

Host settings for this device, almost always dynamic for endpoint.

Username Username configured for this trunk.

Secret Password (secret) configured for the device. Should be alphanumeric with at least 2 letters and
numbers to keep secure.

Port Endpoint port number to use, usually 5060. Some 2 ports devices such as ATA may used 5061

for the second port.

Register String

Most VoIP providers require your system to REGISTER with theirs. Enter the registration line
here.

example:

username:password@switch.voipprovider.com.

Many providers will require you to provide a DID number, ex:
username:password@switch.voipprovider.com/didnumber in order for any DID matching to

work.

Codec

Allow specified codecs, the available codecs are on the left options bar and the selected on the
right.

Advanced

Outbound
CallerID

CallerID for calls placed out on this trunk
Format: <#######>. You can also use the format: “hidden” <#######> to hide the CallerID sent
out over Digital lines if supported (SIP/IAX).

CID Options

Determines what CIDs will be allowed out this trunk. IMPORTANT: EMERGENCY
CIDs defined on an extension/device will ALWAYS be used if this trunk is part of an
EMERGENCY Route regardless of these settings.

Allow Any CID:
transmitted.
Block Foreign CIDs: blocks any CID that is the result of a forwarded call from off the system.
CIDs defined for extensions/users are transmitted.

Remove CNAM: this will remove CNAM from any CID sent out this trunk

Force Trunk CID: Always use the CID defined for this trunk except if part of any
EMERGENCY Route with an EMERGENCY CID defined for the extension/device.

Intra-Company Routes will always transmit an extension’s internal number and name.

all CIDs including foreign CIDS from forwarded external calls will be

Maximum

Channels

Controls the maximum number of outbound channels (simultaneous calls) that can be used on
this trunk. To count inbound calls against this maximum, use the auto-generated context: as the
inbound trunk's context. (see extensions_additional.conf) Leave blank to specify no maximum.

Type

Asterisk connection type, usually friend for endpoint.

Outbound Dial

The outbound dialing prefix is used to prefix a dialing string to all outbound calls placed on this

OpenVox Communication Co. , LTD.
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Prefix trunk. For example, if this trunk is behind another PBX or is a Centrex line, then you would put
9 here to access an outbound line. Another common use is to prefix calls with 'w' on a POTS line
that need time to obtain dial tone to avoid eating digits.

Most users should leave this option blank.

Qualify Setting to yes (equivalent to 2000 msec) will send an OPTIONS packet to the endpoint
periodically (default every minute). Used to monitor the health of the endpoint. If delays are
longer then the quality time, the endpoint will be taken offline and considered unreachable. Can
be set to a value which is the msec threshold. Setting to no will turn this off. Can also be helpful
to keep NAT pinholes open.

Qualifyfreq Frequency in seconds to send qualify messages to the endpoint.

Nat NAT seting, see Asterisk documentation for details. Yes usually works for both internal and
external devices. Set to No if the device will always be internal.

Insecure Specifies how to handle connections with peers. Default no (authenticate all connections).

Dtmfmode The DTMF signaling mode used by this device, usually rfc2833 for most phone.

Trustrpid Whether Asterisk should trust the RPID settings from this device. Usually should be yes for
CONNECTEDLINE( ) functionality to work if supported by the endpoint.

Whether Asterisk should send RPID (or PAI) info to the device. Usually should be enabled to

Sendrpid the settings used by your device for CONNECTEDLINE( ) functionality to work if supported by
the endpoint.

Prack The PRACK request plays the same role as ACK, but for provisional responses.

This sets the allowed transport settings for this device and the default (Primary) transport for
outgoing. The default transport is only used for outbound messages until a registration takes
place. During the peer registration the transport type may change to another supported type if

Transport the peer requests so. In most common cases, this does not have to be changed as most devices
register in conjunction with the host=dynamic setting. If you are using TCP and/or TLS you
need to make sure the general SIP Settings are configured for the system to operate in those
modes and for TLS, proper certificates have been generated and configured. If you are using
websockets (such as WebRTC) then you must select an option that includes WS
Whether to Enable AVPF. Defaults to no. the WebRTC standard has selected AVPF as the audio

Avpf video profile to use for media streams. This is not the default profile in use by Asterisk. As a
result the following must enabled to use WebRTC.

Whether to Enable ICE Support. Defaults to no. ICE (Interactive Connectivity Establishment) is

Icesupport a protocol for Network Address Translator(NAT) traversal for UDP-based multimedia sessions
established with the offer/answer model. This option is commonly enabled in WebRTC setups

Dtlsenable Whether to Enable DTLS for this peer. Defaults to no.

Dtlsverify Whether to verify that the provided peer cerificate is valid. Defaults to no.

Dtlssetup Behavior on DTLS incoming and outgoing connections. Defaults to actpass.

Dtlscertfile Path to certificate file to present

Dtlscafile Path to cafile file to present

Dtlsprivatekey | Path to private key for certificate file.

Whether to offer SRTP encrypted media (and only SRTP encrypted media) on outgoing calls to

Encryption a peer. Calls will fail with HANGUPCAUSE=58 if the peer does not support SRTP. Defaults to

no.

OpenVox Communication Co. , LTD.
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Asterisk Trunk
Dial Options

Asterisk Dial command options to be used when calling out this trunk. To override the Advanced
Settings default, check the box and then provide the required options for this trunk

Continue if

Normally the next trunk is only tried upon a trunk being ‘Congested’ in some form, or

Busy unavailable. Checking this box will force a failed call to always continue to the next configured
trunk or destination even when the channel reports BUSY or INVALID NUMBER.
Figure 2-2-9 Add FXO Trunk
Trunks m
Basic Advanced

Enable Trunk

on

Trunk Name

Group ID

Palicy

Ascending

Member of Groups

Available Selected
FX0-3
FXO0-4
Table2-2-6 Definition Add FXO Trunk
Item Definition
Basic
Enable Trunk Check this to disable this trunk in all routes where it is used.
Trunk Name Descriptive Name for this trunk.
Group ID FXO channels are referenced either by a group number or channel number (which is
defined in chan_dahdi.conf). The default setting is g0 (group zero).
Policy Used to make FXO trunks decisions, help determine the ringing order among multiple
members of group
Member of Groups | Adding FXO ports into trunk groups allow automatic selection of the selected idle port
for outgoing calls.
Advanced
Outbound CallerID | CallerID for calls placed out on this trunk

Format: <#######>. You can also use the format: “hidden” <#######> to hide the
CallerID sent out over Digital lines if supported (SIP/IAX).

OpenVox Communication Co. , LTD.
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CID Options

Determines what CIDs will be allowed out this trunk. IMPORTANT: EMERGENCY
CIDs defined on an extension/device will ALWAY'S be used if this trunk is part of an
EMERGENCY Route regardless of these settings.

Allow Any CID:
be transmitted.
Block Foreign CIDs: blocks any CID that is the result of a forwarded call from off the
system. CIDs defined for extensions/users are transmitted.

Remove CNAM: this will remove CNAM from any CID sent out this trunk

Force Trunk CID: Always use the CID defined for this trunk except if part of any
EMERGENCY Route with an EMERGENCY CID defined for the extension/device.
Intra-Company Routes will always transmit an extension’s internal number and name.

all CIDs including foreign CIDS from forwarded external calls will

Maximum Channels

Controls the maximum number of outbound channels (simultaneous calls) that can be
used on this trunk. Inbound calls are not counted against the maximum. Leave blank to

specify no maximum.

Asterisk Trunk Dial
Options

Asterisk Dial command options to be used when calling out this trunk. To override the
Advanced Settings default, check the box and then provide the required options for this
trunk

Continue if Busy

Normally the next trunk is only tried upon a trunk being ‘Congested’ in some form, or
unavailable. Checking this box will force a failed call to always continue to the next
configured trunk or destination even when the channel reports BUSY or INVALID
NUMBER.

Trunks
Basic
Enable Trunk
on
Trunk Mode

IF Authentication

Trunk Mame*

Host*

Username

Secret
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Table 2-2-7 Definition of Add IAX2 Trunk

Item ‘ Definition
Basic
Enable Trunk Check this to disable this trunk in all routes where it is used.
Trunk Mode Authentication mode of this trunk.
Trunk Name Descriptive Name for this trunk
Host Host settings for this device, almost always dynamic for endpoint.
Username Username configured for this trunk.
Secret Password (secret) configured for the device. Should be alphanumeric with at least 2
letters and numbers to keep secure.
Port Endpoint port number to use, usually 5060. Some 2 ports devices such as ATA may used

5061 for the second port.

Register String

Most VoIP providers require your system to REGISTER with theirs. Enter the
registration line here.

example:

username:password@switch.voipprovider.com.

Many providers will require you to provide a DID number, ex:
username:password@switch.voipprovider.com/didnumber in order for any DID matching

to work.
Codec Allow specified codecs, the available codecs are on the left options bar and the selected
on the right.
Advanced

Outbound CallerID | CallerID for calls placed out on this trunk
Format: <#######>. You can also use the format: “hidden” <#######> to hide the
CallerID sent out over Digital lines if supported (SIP/IAX).

CID Options Determines what CIDs will be allowed out this trunk. IMPORTANT: EMERGENCY

CIDs defined on an extension/device will ALWAYS be used if this trunk is part of an
EMERGENCY Route regardless of these settings.

Allow Any CID: all CIDs including foreign CIDS from forwarded external calls will
be transmitted.

Block Foreign CIDs: blocks any CID that is the result of a forwarded call from off the
system. CIDs defined for extensions/users are transmitted.

Remove CNAM: this will remove CNAM from any CID sent out this trunk

Force Trunk CID: Always use the CID defined for this trunk except if part of any
EMERGENCY Route with an EMERGENCY CID defined for the extension/device.
Intra-Company Routes will always transmit an extension’s internal number and name.

Maximum Channels

Controls the maximum number of outbound channels (simultaneous calls) that can be
used on this trunk. To count inbound calls against this maximum, use auto-generated
context: from-trunk-[trunkname] as the inbound trunk’s context. (see

extesions_additional .conf)Leave blank to specify no maximum.

Type Asterisk connection type, usually friend for endpoint.
Outbound Dial The outbound dialing prefix is used to prefix a dialing string to all outbound calls placed
Prefix on this trunk. For example, if this trunk is behind another PBX or is a Centrex line, then
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you would put 9 here to access an outbound line. Another common use is to prefix calls
with 'w' on a POTS line that need time to obtain dial tone to avoid eating digits.
Most users should leave this option blank.

Qualify Setting to yes (equivalent to 2000 msec) will send an OPTIONS packet to the endpoint
periodically (default every minute). Used to monitor the health of the endpoint. If delays
are longer then the quality time, the endpoint will be taken offline and considered
unreachable. Can be set to a value which is the msec threshold. Setting to no will turn
this off. Can also be helpful to keep NAT pinholes open.

Qualifyfreq Frequency in seconds to send qualify messages to the endpoint.

Nat NAT seting, see Asterisk documentation for details. Yes usually works for both internal
and external devices. Set to No if the device will always be internal.

Insecure Specifies how to handle connections with peers. Default no (authenticate all
connections).

Dtmfmode The DTMF signaling mode used by this device, usually rfc2833 for most phone.

Trustrpid Whether Asterisk should trust the RPID settings from this device. Usually should be yes
for CONNECTEDLINE( ) functionality to work if supported by the endpoint.

Whether Asterisk should send RPID (or PAI) info to the device. Usually should be

Sendrpid enabled to the settings used by your device for CONNECTEDLINE( ) functionality to
work if supported by the endpoint.

Prack The PRACK request plays the same role as ACK, but for provisional responses.

This sets the allowed transport settings for this device and the default (Primary) transport
for outgoing. The default transport is only used for outbound messages until a
registration takes place. During the peer registration the transport type may change to
another supported type if the peer requests so. In most common cases, this does not have

Transport to be changed as most devices register in conjunction with the host=dynamic setting. If
you are using TCP and/or TLS you need to make sure the general SIP Settings are
configured for the system to operate in those modes and for TLS, proper certificates have
been generated and configured. If you are using websockets (such as WebRTC) then you
must select an option that includes WS
Whether to Enable AVPF. Defaults to no. the WebRTC standard has selected AVPF as

Avpf the audio video profile to use for media streams. This is not the default profile in use by
Asterisk. As a result the following must enabled to use WebRTC.
Whether to Enable ICE Support. Defaults to no. ICE (Interactive Connectivity

lcesupport Establishment) is a protocol for Network Address Translator(NAT) traversal for
UDP-based multimedia sessions established with the offer/answer model. This option is
commonly enabled in WebRTC setups

Dtlsenable Whether to Enable DTLS for this peer. Defaults to no.

Dtlsverify Whether to verify that the provided peer cerificate is valid. Defaults to no.

Dtlssetup Behavior on DTLS incoming and outgoing connections. Defaults to actpass.

Dtlscertfile Path to certificate file to present

Dtlscafile Path to cafile file to present

Dtlsprivatekey Path to private key for certificate file.

Encryption Whether to offer SRTP encrypted media (and only SRTP encrypted media) on outgoing
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calls to a peer. Calls will fail with HANGUPCAUSE=58 if the peer does not support
SRTP. Defaults to no.

Asterisk Trunk Dial
Options

Asterisk Dial command options to be used when calling out this trunk. To override the
Advanced Settings default, check the box and then provide the required options for this
trunk.

Continue if Busy

Normally the next trunk is only tried upon a trunk being ‘Congested’ in some form, or
unavailable. Checking this box will force a failed call to always continue to the next
configured trunk or destination even when the channel reports BUSY or INVALID
NUMBER.

Trunks

Basic

Figure 2-2-11 Add CUSTOM Trunk interface

Enable Trunk

On

Trunk Name

Custom Dial String

Table 2-2-8 Definition of Add CUSTOM Trunk

Item

Definition

Basic

Enable Trunk

Check this to disable this trunk in all routes where it is used.

Trunk Name

Descriptive Name for this trunk

Custom Dial String

Define the custom Dial String. Include the token SOUTNUMS$ wherever the number
to dial should go.

examples:

CAPI/XXXXXXXX/SOUTNUMS$S

H323/SOUTNUMS@XX.XX.XX.XX
OH323/$OUTNUMS@XX. XX. XX XX:XXXX

vpb/1-1/$OUTNUMS

Advanced
Outbound CallerID | CallerID for calls placed out on this trunk
Format: <#######>. You can also use the format: “hidden” <#######> to hide the
CallerID sent out over Digital lines if supported (SIP/IAX).
CID Options Determines what CIDs will be allowed out this trunk. IMPORTANT: EMERGENCY

CIDs defined on an extension/device will ALWAYS be used if this trunk is part of an
EMERGENCY Route regardless of these settings.

Allow Any CID: all CIDs including foreign CIDS from forwarded external calls will
be transmitted.

Block Foreign CIDs: blocks any CID that is the result of a forwarded call from off the

system. CIDs defined for extensions/users are transmitted.
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Remove CNAM: this will remove CNAM from any CID sent out this trunk

Force Trunk CID: Always use the CID defined for this trunk except if part of any
EMERGENCY Route with an EMERGENCY CID defined for the extension/device.
Intra-Company Routes will always transmit an extension’s internal number and name.

Maximum Channels

Controls the maximum number of outbound channels (simultaneous calls) that can be
used on this trunk. Inbound calls are not counted against the maximum. Leave blank to

specify no maximum.

Asterisk Trunk Dial
Options

Asterisk Dial command options to be used when calling out this trunk. To override the
Advanced Settings default, check the box and then provide the required options for this
trunk

Continue if Busy

Normally the next trunk is only tried upon a trunk being ‘Congested’ in some form, or
unavailable. Checking this box will force a failed call to always continue to the next
configured trunk or destination even when the channel reports BUSY or INVALID
NUMBER.

3.3 Call Control

3.3.1 Inbound Routes

When a call comes into your system from the outside, it will usually arrive along with information

about the telephone number that was dialed (also known as the "DID") and the Caller ID of the

person who called.

The Inbound Routes module is used to tell your system what to do with calls that come into your
system on any trunk that has the "context=from-trunk" parameter in the PEER details.

Figure 2-2-12 Add incoming Route interface

Inbound Routes m

Basic Advanced

Description

test

DID Number

CallerlD Number

CID Priority
Route

OFF

Inbound Destination

Extensions

=101= 101
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Table 2-2-9 Definition of Add incoming Route

Item ‘ Definition
Basic
Description Provide a meaningful description of what this incoming route is
DID Number Define the expected DID Number if your trunk passes DID on incoming calls.
Leaving this blank to match calls with any or no DID info.
You can also use a pattern match (eg_2[345]X) to match a range of numbers.
CallerID Number Define the CallerID Number to be matched on incoming calls.
Leave this field blank to match any or no CID info. In addition to standard dial
sequences, you can also put Private, Blocked, Unknown, Restricted, Anonymous and
Unavailable in order to catch these special cases if the Telco transmits them.
CID Priority Route | This effects CID ONLY routes where no DID is specified. If checked, calls with this CID

will routed to this route, even if there is a route to the DID that was called. Normal
behavior is for the DID route to take the calls. If there is a specific DID/CID route for
this CID, that route will still take the call when that DID is called.

Inbound Destination

Indicates extension, Ring Group, Voicemail or other destination to which the call is

suppoesd to be directed when the outside callers have called specified DID Number

Advanced

Alert Info ALERT INFO can be used for distinctive ring with SIP devices.

CID name prefix You can optionally prefix the CallerID name. ie: If you prefix with “Sales:”, a call from
john Doe would display as “Sales: John Doe” on the extension that ring

Music On Hold Set the MoH class that will be used for calls that come in on this route. For example,
choose a type appropriate for routes coming in from a country which may have
announcements in their language.

Signal RINGING Some devices or providers require RINGING to be sent before ANSWER. You’ll notice

this happening if you can send calls directly to a phone, but if you send it to an IVR, it
won’t connect the call.

Pause Before
Answer

An optional delay to wait before processing this route. Setting this value will delay the
channel from answering the call. This may be handy if external fax equipment or security
systems are installed in parallel and you would like them to be able to seize the line.

Privacy Manager

If no CallerID has been received, Privacy Manager will ask the caller to enter their phone
number. If an user/extension has Call Screening enabled, the incoming caller will be

prompted to say their name when the call reaches the user/extension.

Call Recording

Controls or overrides the call recording behavior for calls coming into this DID. Allow
will honor the normal downstream call recording settings. Record on Answer starts
recording when the call would otherwise be recorded ignoring any settings that say
otherwise. Record Immediately will start recording right away capturing ringing,
announcements, MoH, etc. never will disallow recording regardless of downstream

settings.

Source

Source can be added in Caller Name Lookup Sources section.

Language

Allows you to set the language for this DID.

Fax Detect

Attempt to detect faxes on this DID.
*  No: No attempts are made to auto-determine the call type; all calls sent to
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destination below. Use this option if this DID is used exclusively for voice OR fax.
Yes: try to auto determine the type of call; route to the fax destination if call is a fax,

otherwise send to regular destination. Use this option if you receive both voice and

fax calls on this line.

3.3.2 Outbound Routes

The Outbound Routes Module is used to tell your FreePBX/Asterisk system which numbers your
phones are permitted to call and which Trunk to send the calls to.

Generally, a FreePBX/Asterisk system will have a Restricted route which designates certain numbers
that can never be dialed (such as 900 and 976 numbers), an Emergency route to use for routing110
calls, and a route for ordinary calls. A phone system might also have special routes for interoffice
calls, international calls, and other special circumstances

Figure 2-2-13 Outbound Routes interface

Outbound Routes m
Route Name
Override Extension CID
Route Password
Dial Patterns that will use this Route
[ . 1%
+ Add More Dial Pattern Fields
Dial patterns wizards
Export Dialplans as CSV | Export
o B ¢
[ > ]
[« ]
Table2-2-10 Definition of Outbound Routes
Item Definition
Basic
Route Name Name of this route. Should be used to describe what type of calls this route matches (for
example, 'local' or 'longdistance").
Route CID Optional Route CID to be used for this route. If set, this will override all CIDS specified
except:
extension/device EMERGENCY CIDs if this route is checked as an
EMERGENCY Route
trunk CID if trunk is set to force it's CID
® Forwarded call CIDs (CF, Follow Me, Ring Groups, etc)
Extension/User CIDs if checked
75
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Route Password

Optional: A route can prompt users for a password before allowing calls to progress. This
is useful for restricting calls to international destinations or 1-900 numbers.

A numerical password, or the path to an Authenticate password file can be used.

Leave this field blank to not prompt for password.

Dial Patterns that
will use this
Route

A Dial Pattern is a unique set of digits that will select this route and send the call to the
designated trunks. If a dialed pattern matches this route, no subsequent routes will be tried.
If Time Groups are enabled, subsequent routes will be checked for matches outside of the
designated time(s).

Rules:

X matches any digit from 0-9

7. matches any digit from 1-9

N matches any digit from 2-9

[1237-9] matches any digit in the brackets (example: 1,2,3,7,8,9). wildcard, matches one
or more dialed digits

Prepend:  Digits to prepend to a successful match. If the dialed number matches the
patterns specified by the subsequent columns, then this will be prepended before sending to
the trunks.

Prefix: Prefix to remove on a successful match. The dialed number is compared to this and
the subsequent columns for a match. Upon a match, this prefix is removed from the dialed
number before sending it to the trunks.

Match pattern: The dialed number will be compared against the prefix + this match
pattern. Upon a match, the match pattern portion of the dialed number will be sent to the
trunks.

CallerID: If CallerID is supplied, the dialed number will only match the prefix + match
pattern if the CallerID being transmitted matches this. When extensions make outbound
calls, the CallerID will be their extension number and NOT their Outbound CID. The above
special matching sequences can be used for CallerID matching similar to other number
matches.

Dial patterns

wizards

These options provide a quick way to add outbound dialing rules. Follow the prompts for
each.

Lookup local prefixes This looks up your local number on ww.localcallingguide.com
(NA-only), and sets up so you can dial either 7, 10 or 11 digits (5551234, 6135551234,
16135551234) to access this route.

Upload from CSV Upload patterns from a CSV file replacing existing entries. If there are
no headers then the file must have 4 columns of patterns in the same order as in the GUL
You can also supply headers: prepend, prefix, match pattern and callerid in the first row.
If there are less than 4 recognized headers then the remaining columns will be blank.

Add Trunks

Trunks used by this outbound route, the available trunks are on the left options bar and the
selected on the right.

Advanced

Route Type

Optional: Selecting Emergency will enforce the use of a device

Music On Hold

You can choose which music category to use. For example, choose a type appropriate for a

destination country which may have announcements in the appropriate language.
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Time Group If this route should only be available during certain times then Select a Time Group created
under Time Groups. The route will be ignored outside of times specified in that Time Group.
If left as default of Permanent Route then it will always be available.

Route Position Where to insert this route or relocate it relative to the other routes.

Call Recording Controls or overrides the call recording behavior for calls coming into this DID. Allow will
honor the normal downstream call recording settings. Record on Answer starts recording
when the call would otherwise be recorded ignoring any settings that say otherwise. Record
Immediately will start recording right away capturing ringing announcements, MoH, etc.
Never will disallow recording regardless of downstream settings.

PIN Set Optional: Select a PIN set to use. If using this option, leave the Route Password field blank.
Optional If all the trunks fail because of Asterisk ‘CONGESTION?” dial status you can optionally go to
Destination on a destination such as a unique recorded message or anywhere else. This destination will
Congestion NOT be engaged if the trunk is reporting busy, invalid numbers or anything else that would

imply the trunk was able to make an ‘intelligent’ choice about the number that was dialed.
The ‘Normal Congestion’ behavior is to play the ‘ALL Circuits Busy’ recording or other
options configured in the route Congestion Messages module when installed.

3.3.3 Blacklist

The blacklist module is used to add a phone number to a blacklist or remove a phone number from a
blacklist. You can also choose to blacklist any blocked or unknown calls.

When a number is blacklisted, any calls with that number in the Caller ID field received by the
system will be routed to the disconnected record.
Figure 2-2-14 Blacklist interface

Blacklist
Inbound blacklist OQutbound blacklist
Blacklist
v
Enable .

Blacklist File

Number/CallerlD
Description

Block
Unknown/Blocked OFF
Caller ID
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Inbound blacklist Outbound blacklist
Blacklist
v
Enable .

The blacklist (based on CalleelD) is used for all outbound routes.

Country Codes

(£ North America

[+l South America

[+ Europe

--|:| Asia and the Middle East

1 Africa

[+}1_I Oceania

Blacklist Manage

Add Blacklist Rule

Continent Country Blacklist Rule

3.3.4 Call Flow Control

The Call Flow Control module is used to create a single destination that can act as a switch that can
be toggled by anyone who has access to a local phone. It is commonly used to allow phone system
users to manually switch between "Daytime Mode" and "Nighttime Mode."

Call Flow Control should not be confused with Time Conditions. While both of these modules relate
to call flow, Call Flow Control is designed to be a manual switch, while a Time Condition is
designed to be a scheduled, automatic switch.
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Figure 2-2-15 Call flow control interface

Call Flow Control m

Basic

Feature Code Index

0

Name

Green

Current Mode

Mormal (Green/BLF off) r

Recording for Normal Mode

Default T

Recording for Override Mode

Default v

Optional Password

Normal Flow (Green/BLF off)

Ring Groups r

default ring group <600= r

Override Flow (Red/BLF on)

== choose one == b

Table 2-2-12 Definition of Call flow control

Item Definition

Call Flow Toggle There are a total of 10 Feature code objects,0-9, each can control a call flow and be
Feature Code Index | toggled using the call flow toggled feature code plus the index

Name Description for this Call Flow Toggle Control

Current Mode This will change the current state for this Call Flow Toggle Control, or set the initial
state when creating a new one.

Recording for Message to be played in normal mode (Green/BLF off)

Normal Mode To add additional recordings use the “System Recordings” MENU to the left

Recording for Message to be played in override mode (Green/BLF off)

Override Mode To add additional recordings use the “System Recordings” MENU to the left

Optional Password You can optionally include a password to authenticate before toggling the call flow. If

left blank anyone can use the feature code and it will be un-protected
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Normal Flow Destination to use when set to Normal Flow (Green/BLF off) mode
(Green/BLF off)

Override Flow Destination to use when set to Override Flow (Red/BLF off) mode
(Red/BLF on)

3.3.5 Time Conditions

You can create various time conditions and use these time conditions in conjunction with your
Inbound Route to individualise each of the incoming trunk’s behavior.
Figure 2-2-16 Time Conditions interface

Time Conditions m

Basic

Time Condition name

test

Current Override: No Override

Change Override

Unchanged r
Time Group
workdays A

Destination if time matches

Ring Groups r

default ring group =600= r

Destination if time does not matches

Extensions v

<101= 101 v

Table 2-2-13 Definition of add Time Conditions

Item Definition

Time Condition Give this Time Condition a brief name to help you identify it.

name

Time Group Select a time group created under Time Groups. Matching times will be sent to
matching destination. If no group is selected, call will always go to no-match
destination.
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3.3.6 Time Groups

The Time Groups Module is used to define periods of time that can then be selected in the Time
Conditions module or Outbound Routes module.

For example, you might create a Time Group called "Lunch” that might start at 12:00 p.m and end at
1:00 p.m. You could then create a Time Condition that would use the Lunch Time Group to send
calls to voicemail during lunch, and to a ring group at other times.

Figure 2-2-17 Time Groups interface

Time Groups m

Basic
Time
09 v : 00 v TO 18 v : 00 v
Week Day Start to finish
Maonday v TO Friday v
Maonth Day Start to finish
v TO 3 v
Month Start to finish
v TO v

Name

workdays

3.3.7 PIN Sets

FreePBX allows you to require callers to dial a password before an outbound call will go through.
You can require a password on all calls, or only on calls to certain numbers.

The PIN Sets Module allows you to create define groups and then assign a list of passwords to each
group. You can then restrict certain calls to certain groups by going to the Outbound Routes Module
and limiting the route to a certain PIN Set group. Each Outbound Route can be limited to just one
PIN Set group. So, if you want to allow more than one PIN Set group to make a certain type of call,
just create a duplicate Outbound Route and assign the second Outbound Route to a different PIN Set
Group.
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Figure 2-2-18 PIN Sets Interface

PIN Sets m

Basic

Name
pin
Record In
COR [ on |
PIN List
123

456
789

Table 2-2-14 Definition of add PIN Set

Item Definition
Record In CDR | Select this box if you would like to record the PIN in the call detail records when used.
PIN List Enter a list of one more PINs. One PIN per line.

3.3.8 FXO Channels DIDs

The FXO Channel DIDs module allows you to assign a DID or phone number to specific analog
channels.

Unlike SIP or PRI trunks, analog lines do not send a DID or dialed number to the PBX. Since the
PBX routes all inbound calls based on the DID or number dialed, we need to map each analog port or
channel to a fake number so we can match that number to an Inbound Route number and route your
calls.

Each channel can be mapped to the same phone number if you want all calls on the analog lines to go
to the same destination. This would be a common scenario if you have multiple POTS lines that are
on a hunt group from your provider.

Figure 2-2-19 Add FXO Channel interface-
FXO Channels DIDs m

Basic

Channel

FX0-3 v

Description

DID
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Table 2-2-15 Definition of Add FXO Channel

Item Definition
Channel The FXO Channel number to map to a DID

Description | A useful description this channel

DID The DID that this channel represents. The incoming call on this channel will be treated

as if it came in with this DID and can be managed with Inbound Routing on DIDs

3.3.9 AutoCLIP Route

AutoCLIP Routes m

AutoCLIP Routes AutoCLIP List

Delete Used Record Keep
v

Records: . Time: Shour ¥
Only Keep Missed s - .
Call Records: ] Digits Match: 1
Match Outgoing
Trunk:
Member Trunks:

Available Selected

DAHDIFXO Channel Group 0

3.4 Call Features

3.4.11VR

The IVR module allows you to create one or more IVRs ("Interactive Voice Response" systems or
Auto Attendants). You can then route calls to the IVR and play a recording prompting callers what
options to enter, such as “press 1 for sales and press 2 for the company directory.” An IVR can also
route calls to another IVR, or in other words, a sub-menu. As a general rule, you never want more
than five or six options in a single IVR, or it will become too confusing to navigate. It is better to
only include a few options at a single menu level, and route callers to a sub-menu for more choices.
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VR

IVR. Name

IVR

Basic

IVR Name

IVR Description

Announcement

Figure 2-2-20 IVR interface

W Delete n

IVR Description Announcement Direct Dial

Mone

v

o] Upload =+ Download

Direct Dial

Disabled

Timeout

Invalid Retries

Disabled

Invalid Retry Recording

Mone

Append Announcement on Invalid

OFF

Return on Invalid OFF
Invalid Recording
Nons v
Invalid Destination
== choose one = v
Table 2-2-16 Definition of add IVR
Item Definition
Basic
IVR Name Name of this IVR
IVR Description Description of this ivr
Announcement Greeting to be played on entry to the IVR.
Direct Dial Provides options for callers to direct dial an extension. Direct dialing can be:
® Completely disabled
® Enabled for all extensions on a system
Timeout Amount of time to be considered a timeout

Invalid Retries

Number of time to retry when receiving an invalid/unmatched response from the caller

Invalid Retry Prompt to be played when an invalid/unmatched response is received, before prompt the
Recording caller to try again
Append After playing Invalid Retry Recording the system will replay mail IVR Announcement

OpenVox Communication Co. , LTD.

84
URL: www.openvox.cn




OpenVox

UC501 User Manual

Announcement on
Invalid

Return on Invalid

Check this box to have this option return to a parent IVR if it was called from a parent
IVR. If not, it will go to the chosen destination.

The return path will be to any IVR that was in the call path prior to this IVR which could
lead to strange result if there was an IVR called in the call path but not immediately
before this.

Invalid Recording

Prompt to be played before sending the caller to an alternate destination due to the caller
pressing 0 or receiving the maximum amount of invalid/unmatched responses (as
determined by Invalid Retries)

Invalid Destination

Destination to send the call to after Invalid recording is played.

Timeout Retries

Number of times to retry when no DTMF is heard and the IVR choice time out.

Timeout Retry Prompt to be played when a timeout occurs, before prompting the caller to try again
Recording
Append After playing the Timeout Retry Recording the system will replay the main IVR

Announcement on

Timeout

Announcement.

Return on Timeout

Check this box to have this option return to a parent IVR if it was called from a parent
IVR. If not, it will go to the chosen destination.

The return path will be to any IVR that was in the call path prior to this IVR which could
lead to strange result if there was an IVR called in the call path but not immediately
before this

Timeout Recording

Prompt to be played before sending the caller to an alternate destination due to the caller
pressing 0 or receiving the maximum amount of invalid/unmatched responses(as
determined by Invalid Retries)

Timeout Destination

Destination to send the call to after Timeout Recording is played.

Return to IVR after

If checked, upon exiting voicemail a caller will be returned to this IVR if they got a user

VM voicemail
Return Return to IVR
Delete Check this box to have this option return to a parent IVR if it was called from a parent

IVR. If not, it will go to the chosen destination.

The return path will be to any IVR that was in the call path prior to this IVR which could
lead to strange result if there was an [VR called in the call path but immediately before
this.

3.4.2 Queues

The Queues module is a more advanced version of the Ring Groups module. Like the Ring Groups
module, the Queues module is used to create an extension number that your users can dial in order to
ring multiple extensions at the same time. It also creates a destination to which you can send calls
that will ring those multiple extensions.

85

OpenVox Communication Co. , LTD. URL: www.openvox.cn



OpenVox

UC501 User Manual

Figure 2-2-21 Queues interface

Queues m

Basic General Queue Options Timing & Agent Options Capacity Options
CQueue Name
123

Queue Password

test

Generate Device Hints OFF Call Confirm OFF

Call Confirm Announce

Default v

CID Mame Prefix

Wait Time Prefix

Mo v

Alert Info

Static Agents
Available Selected

101 (101) -
103 (103)
104 (104)
105 (105)
106 (106)
107 (107)
108 (108) M

102 (102} -

Dynamic Members

Available Selected

101 {(101) - 102 (102} -

Table 2-2-17 Definition of add Queues

Item Definition

Basic

Queue Number Use this number to dial into the queue, or transfer callers to this number to put them into the
queue.

Agents will dial this queue number plus* to log the queue, and this queue number plus** to
log out the queue.
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For example, if the queue number is 123:
123*=log in
123**=]og out

Queue Name

Give the queue a brief name to help you identify it.

Queue Password

You can require agents to enter a password before they can log in to this queue.

This setting is optional.

The password is only used when logging in with the legacy queue no* code. When using the
toggle codes, you must use the Restrict Dynamic Agents option in conjunction with the
Dynamic Members list to control access.

Generate Device
Hints

If checked, individual hints and dialplan will be generated for each SIP and IAX2 device that
could be part of this queue. These are used in conjunction with programmable BLF status as to
the current state, the format of this hints is

*45ddd*qqq

Where *45 is the currently define toggle feature code, ddd is the device number (typically the
same as the extension number) and qqq is this queue’s number

Call Confirm

If checked, any queue member that is actually an outside telephone number, or any extension
Follow-Me or call forwarding that are pursued and leave the PBX will be forced into Call
Confirmation mode where the member must acknowledge the call before it is answered and
delivered.

Call Confirm

Announce

Announcement played to the Queue Member announcing the Queue call and requesting
confirmation prior to answering. If set to default, the standard call confirmation default
message will be played unless the number is reached through a Follow-Me and this is an
alternate message provided in the Follow-Me. This message will override any other message
specified.

To add additional recordings please use the “System Recordings” MENU.

CID Name Prefix

You can optionally prefix the CallerID name of callers to the queue. ie: If you prefix with
“Sales:”, a call from John Doe would display as “Sales: John Doe” on the extensions that ring.

Wait Time Prefix

When set to Yes, the CID Name will be prefix with the total wait time in the queue so the
answering agent is aware how long they have waited. It will be rounded to the nearest minute,
in the form of Mnn: where nn is the number of minutes.

If the call is subsequently transferred, the wait time will reflect the time since it first entered
the queue or reset if the call is transferred to another queue with this feature set.

Alert Info

ALERT INFO can be used for distinctive ring with SIP device.

Static Agents

Static agents are extensions that are assumed to always be on the queue. Static agents do not
need to 'log in' to the queue, and cannot 'log out' of the queue.

List extensions to ring, one per line.

You can include an extension on a remote system, or an external number (Outbound

Routing must contain a valid route for external numbers). You can puta ","

after the agent
followed by a penalty value, see Asterisk documentation concerning penalties.

An advanced mode has been added which allows you to prefix an agent number with S, X, Z,
D or A. This will force the agent number to be dialed as an Asterisk device of type SIP, [AX2,
ZAP, DAHDI or Agent respectively. This mode is for advanced users and can cause known

issues in FreePBX as you are by-passing the normal dialplan. If your 'Agent Restrictions' are
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not set to 'Extension Only' you will have problems with subsequent transfers to voicemail and
other issues may also exist.
(Channel Agent is deprecated starting with Asterisk 1.4 and gone in 1.6+.)

Dynamic
Members

Dynamic Members are extensions or callback numbers that can log in and out of the queue.
When a member logs in to a queue, their penalty in the queue will be as specified here.
Extensions included here will NOT automatically be logged in to the queue.

Restrict Dynamic
Agents

Restrict dynamic queue member logins to only those listed in the Dynamic Members list
above. When set to Yes, members not listed will be DENIED ACCESS to the queue.

Agent
Restrictions

When set to ‘Call as Dialed’ the queue will call an extension just as if the queue were another
user. Any Follow-Me or Call Forward states active on the extension will result in the queue
call following these call paths. This behavior has been the standard queue behavior on past
FreePBX versions.

When set to ‘No Follow-Me or Call Forward’, all agents that are extensions on the system will
be limited to ring their extensions only. Follow-Me and Call Forward settings will be ignored.
Any other agent will be called as dialed. This behavior is similar to how extensions are dialed
in ringgroups

When set to ‘Extensions Only’ the queue will dial Extensions as described for ‘No Follow —
Me or Call Forward’. Any other number entered for an agent that is NOT a valid extension
will be ignored. No error checking is provided when entering a static agent or when logging on
as a dynamic agent, the call will simply be blocked when the queue tries to call it. For dynamic
agents, see the ‘Agent Regex filter’ to provide some validation.

General Queue Options

Ring Strategy

Ringall: ring all available agents until one answers (default)

Leastrecent: ring agent which was least recently called by this queue

Fewestcalls: ring the agent with fewest completed calls from this queue

Random: ring random agent

Rrmemory: round robin with memory, remember where we left off last ring pass
Rrordered: same as rrmemory, except the queue member where order from config file is
preserved

Linear: rings agents in the order specified, for dynamic agents in the order they logged in
Wrandom: random using the member’s penalty as a weighting factor, see asterisk
documentation for specifics.

Autofill

Starting with Asterisk 1.4, if this is checked, and multiple agents are available, Asterisk will
send one call to each waiting agent(depending on the ring strategy). Otherwise, it will hold all
calls while it tries to find an agent for the top call in the queue making other calls wait. This
was the behavior in Asterisk 1.2 and has no effect in 1.2. See Asterisk documentation for more

details of this feature.

Skip Busy Agents

When set to 'Yes' agents who are on an occupied phone will be skipped as if the line were
returning busy. This means that Call Waiting or multi-line phones will not be presented with
the call and in the various hunt style ring strategies, the next agent will be attempted.

When set to 'Yes + (ringinuse=no)' the queue configuration flag 'ringinuse=no' is set for this
queue in addition to the phone's device status being monitored. This results in the queue
tracking remote agents (agents who are a remote PSTN phone, called through Follow-Me, and
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other means) as well as PBX connected agents, so the queue will not attempt to send another
call if they are already on a call from any queue.

When set to 'Queue calls only (ringinuse=no)' the queue configuration flag 'ringinuse=no' is set
for this queue also but the device status of locally connected agents is not monitored. The
behavior is to limit an agent belonging to one or more queues to a single queue call. If they are
occupied from other calls, such as outbound calls they initiated, the queue will consider them
available and ring them since the device state is not monitored with this option.

WARNING: When using the settings that set the 'ringinuse=no' flag, there is a NEGATIVE
side effect. An agent who transfers a queue call will remain unavailable by any queue until that
call is terminated as the call still appears as 'inuse' to the queue UNLESS 'Agent Restrictions'
is set to 'Extensions Only'.

Queue Weight Gives queue a ‘weight’ option, to ensure calls waiting in a higher priority queue will deliver its
calls first if there are agents common to both queues.

Music on Hold Music (MoH) played to the caller while they wait in line for an available agent. Choose

Class “inherit” if you want the MoH class to be what is currently selected, such as by the inbound
route. MoH Only will play music until the agent answers. Agent Ringing will play MoH until
an agent’s phone is presented with the call and is ringing. If they don’t answer MoH will
return. Ring only makes callers hear a ringing tone instead of MoH ignoring any MoH class
selected as well as any configured periodic announcements. This music is defined in the
“Music on Hold” Menu.

Join Announcement played to callers prior to joining the queue. This can be skipped if there are

Announcement agents ready to answer a call (meaning they still may be wrapping up from a previous call) or
when they are free to answer the call right now. To add additional recordings please use the
“System Recordings” MENU.

Call Recording Incoming calls to agents can be recorded. (saved to /var/spool/asterisk/monitor)

Recording Mode | Choose to ‘Include Hold Time’ in the recording so it starts as soon as they enter the queue, or
to defer recording until ‘After Answered’ and the call is bridged with a queue member.

Caller Volume Adjust the recording volume of the caller.

Adjustment

Agent Volume Adjust the recording volume of the queue member (Agent).

Adjustment

Mark calls Enabling this option, all calls are marked as ‘answered elsewhere’ when cancelled. The effect

answered is that missed queue calls are *not* shown on the phone(if the phone support it)

elsewhere

Timing & Agent Options

Max Wait Time The maximum number of seconds a caller can wait in a queue before being pulled out.(0 for
unlimited).

Max Wait Time Asterisk timeoutpriority. In ‘Strict’ mode, when the ‘Max Wait Time’ of a caller is hit, they

Mode will be pulled out of the queue immediately. In ‘Loose’ mode, if a queue stops ringing with

this call, then we will wait until the queue stops ringing this queue number or otherwise the
call is rejected by the queue member before taking the caller out of the queue. This means that
the ‘Max Wait Time’ could be as long as ‘Max Wait Time’+’Agent Timeout’ combined.

Agent Timeout

The number of seconds an agent’s phone can ring before we consider it a timeout. Unlimited
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or other timeout values may still be limited by system ringtime or individual extension
defaults.

Agent Timeout
Restart

If timeout restart is set to yes, then the time out for an agent to answer is reset if a BUSY or
CONGESTION is received. This can be useful if agents are able to cancel a call with reject or
similar

Retry

The number of seconds we wait before trying all the phones again. Choosing “No Retry” will
exit the queue and go to the fail-over destination as soon as the first attempted agent time-out,
additional agents will not be attempted.

Wrap-Up-Time

After a successful call, how many seconds to wait before sending a potentially free agent
another call (default is 0, or no delay) If using Asterisk 1.6+, you can also set the ‘Honor
Wrapup Time Across Queues setting (Asterisk: shared lastcall) on the Advanced Settings page
so that this is honored across queues for members logged on to multiple queues.

Member Delay If you wish to have a delay before the member is connected to the caller (or before the member
hears any announcement messages), set this to the number of seconds to delay.

Agent Announcement played to the Agent prior to bridging in the caller.

Announcement Example : “’the Following call is from the Sales Queue” or “This call is from the Technical
Support Queue”.
To add additional recordings please use the “System Recordings” MENU. Compound
recordings composed of 2 or more sound files are not displayed as options since this feature
can not accept such recordings.

Report Hold Time | If you wish to report the caller’s hold time to the member before they are connected to the
caller, set this to yes.

Auto Pause Auto Pause an agent in this queue (or all queues they are a member of ) if they don’t answer a

call. Specific behavior can be modified by the Auto Pause Delay as well Auto Pause
Busy/Unavailable settings if supported on this version of Asterisk.

Auto Pause on

Busy

When set to Yes agents devices that report busy upon a call attempt will be considered as a
missed call and auto paused immediately or after the auto pause delay if configured

Auto Pause on

When set to Yes agents devices that report congestion upon a call attempt will be considered as

Unavailable a missed call and paused immediately or after that auto pause delay if configured

Auto Pause Delay | This setting will delay the auto pause of an agent by auto pause delay seconds from when it
last took a call. For example, if this were set to 120 seconds, and a new call is presented to the
agent 90 seconds after they last took a call, will not be auto paused if they don’t answer the
call. If presented with a call 120 seconds or later after answering the last calls, this will have
no effect.

Capacity Options
Max Callers Maximum number of people waiting in the queue (0 for unlimited )
Join Empty Determines if new callers will be admitted to the Queue, if not, the failover destination will be

immediately pursued. The options include:

® Yes Always allows the caller to join the Queue.

®  Strict Same as Yes but more strict. Simply speaking, if no agent could answer the phone
then don’t admit them. If agents are infuse or ringing someone else, caller will still be
admitted.

® Ultra Strict Same as Strict plus a queue member must be able to answer the phone ‘now’
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to let them in. simply speaking, any ‘available’ agents that could answer but are currently
on the phone or ringing on behalf of another caller will be considered unavailable.

® No Callers will not be admitted if all agents are paused, show an invalid status for their
device, or have penalty values less than QUEUE_MAX PENALTY (not currently set in
FreePBX dialplan).

® Loose Same as No except Callers will be admitted if there are paused agents who could
become available.

Leave Empty Determines if callers should be exited prematurely from the queue in situations where it
appears no one is currently available to take the call. The options include:
®  Yes Callers will exit if all agents are paused, show an invalid state for their device or have
penalty values less than QUEUE_MAX PENALTY (not currently set in FreePBX
dialplan)
®  Strict Same as Yes but more strict. Simply speaking, if no agent could answer the phone
then have them leave the queue. If agents are inuse or ringing someone else, caller will
still be held.
® Ultra Strict Same as Strict plus a queue member must be able to answer the phone ‘now’
to let them remain. simply speaking, any ‘available’ agents that could answer but are
currently on the phone or ringing on behalf of another caller will be considered
unavailable.
® Loose Same as No except Callers will remain in the queue, if there are paused agents
who could become available.
® No never have a caller leave the Queue until the Max Wait Time has expired.
Penalty Members | Asterisk: penalty members limit. A limit can be set to disregard penalty settings, allowing all
Limit members to be tried, when the queue has too fewer members. No penalty will be weight in if
there are only X or fewer queue members.
Frequency How often to announce queue position and estimated holdtime (0 to Dis able Announcements).
Announce Announce position of caller in the queue
Position

Announce Hold

Should we include estimated hold time in position announcements? Either yes, no, or only

Time once; hold time will not be announced if <1 minute.

IVR Break Out You can optionally present an existing IVR as a ‘break out’ menu.

Menu This IVR must only contain single-digit ‘dialed options’. The recording set for the IVR will be
played at intervals specified in ‘Repeat Frequency’, below.

Repeat Frequency | How often to announce a voice menu to the caller (0 disable Announcements)

Event When When this option is set to YES, the following manager events will be generated: AgentCalled,

Called AgentDump, AgentConnect and AgentComplete.

Member Status
Event

When set to YES, the following manager event will be generated: QueueMemberStatus.

Service Level

Used for service level statistics (calls answered within service level time frame)

Agent Regex
Filter

Provides an optional regex expression that will be applied against the agent callback number.
If the callback number does not pass the regex filter then it will be treated as invalid. This can
be used to restrict agents to extensions within a range, not allow callbacks to include keys like
* or any other use that may be appropriate. An example input might be:
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N([2-4][0-91{3})$

This would restrict agents to extensions 2000-4999. Or

([0-9]+)$ would allow any number of any length, but restrict the * key.

WARNING: make sure you understand what you are doing or otherwise leave this blank!

Run

Select how often to reset queue stats. The following schedule will be followed for all but
custom:

Hourly Run once an hour, beginning of hour

Daily Run once a day, at midnight

Weekly Run once a week, midnight on Sun

Monthly Run once a month, midnight, first of month

Annually Run once a year, midnight, Jan.1

Reboot Run at startup of the server OP of the cron deamon (i.e. after every service cron
restart )

If Randomize is selected, a similar frequency will be followed, only the exact times will

randomized (avoiding peak business hours, when possible). Please note: randomized schedules

will be rescheduled (randomly) every time ANY backup is saved.

Penalty Members

Limit

the phone(s) that are rung

Queues by default will sort callers with a first in, first out order. The Queue Priority module allows
you weight some callers differently from others. By giving certain callers a higher priority, they are
allowed to bypass all of the other callers with a lower priority to receive faster service. The default

setting is for all callers to have a priority of zero. Callers with a higher number will be placed in front

of priority zero callers. Queue priorities are often used when providing service level agreements

(SLAs).
Figure 2-2-22 Queue Priorities interface
Queues m
Basic
Description
Priority
|:| v
Destination
== choose one == ¥
Table 2-2-18 Definition of add Queue Priorities
Item Definition
Description The descriptive name of this Queue Priority instance
Priority The Queue Priority set
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3.4.3 Phonebook

With the Phonebook module, we can have a centralized list of numbers that can be accessed by the
users. Each number of this list has a special code in order to dial it quicker than by dialing the
number itself.

Figure 2-2-23 Phonebook interface

Phonebook
s L e
Mame Mumber Speed dial code

Navigate to PBX > Call Control > Phonebook, Add a speed dial number by using the following

information.
Table 2-2-19 Definition of Phonebook

Item Definition

Speed Dial This option must be checked

Name Name of the speed dial

Number Destination external number

Speed dial code A number to associate this code to the external number to dial

The next screenshot shows this configuration:

Phonebook m

Basic

Speed Dial ON

MName

Number

Speed dial code

To dial this speed dial number, we dial *088, where *0 is to access the speed dial system's feature
and 88 is the speed dial code we entered.

Some actions that we can perform on the speed dial administration web page are as follows:

® Export in CSV: If we click on this link, we can download the current speed dial list.

® Import from CSV: We can upload a CSV file with the format: “Name”’; Number; Speeddial
Navigate to PBX > Settings > Functions Code, switch the Speeddial prefix to Enabled.
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Speed Dial Functions

Set user speed dial =75 m Enabled v

‘ Speeddial prefix 0 m Enabled v

3.4.4 Wakeup Service

User can enable the Wakeup service and set the time and date, members, and receive the call
reminder after the time.
Figure 2-2-24 Wakeup Service Interface

Wakeup Service m

Basic

Enable Wakeup Service

Name

Prompt

default.wav v

Custom Date
Date Sun Mon Tue Wed Thu Fri Sat All
Time

00 0o v

Members
Available Selected
101
102
103
104
105
106
107 h

“
Al

3.4.5 DISA

DISA (Direct Inward System Access) allows you to dial in from outside to the Asterisk switch (PBX)
to obtain an "internal" system dial tone. You can place calls from it as if they were placed from
within.
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DISA

Basic

DISA name

PIN

Response Timeout
10
Digit Timeout

5

Require Confirmation

Caller ID

Context

from-internal

Allow Hangup
Caller ID Override

Enable

Figure 2-2-24 DISA Interface

OFF

OFF

When you choose the DISA option to call a number, you will be greeted with “Please enter your
password followed by the pound key” and after entering your password, you will then get a dial tone.
You may start dialing the telephone number.

Table 2-2-20 Definition of add DISA

Item Definition
DISA name Give this DISA a brief name to help you identify it.
PIN The user will be prompted for this number. If you wish to have multiple PIN’s, separate

them with commas.

Response Timeout

The maximum amount of time it will before hanging up if the user has dialed an
incomplete or invalid number. Default of 10 seconds.

Digit Timeout The maximum amount of time permitted between digits when the user is typing in an
extension. Default of 5.

Require Require Confirmation before prompting for password. Used when your PSTN connection

Confirmation appears to answer the call immediately.

Caller ID (Optional ) When using this DISA, the users CallerID will be set to this. Format is “User
Name” <5551234>

Context (Experts Only)Set the context that calls will originate from. Leaving this as from-internal
unless you know what you’re doing.

Allow Hangup Allow the current call to be disconnected and dial tone presented for a new call by
pressing the Handup feature code: ** while in a call.

Caller ID Override | Determine if we keep the Caller ID being presented or if we override it. Default is Enable.
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3.4.6 Conference

The Conference option is used to create a single extension number that your users can dial so that
they can talk to each other in a conference call. It also creates a destination to which you can send
calls so that they can participate in the conference call.
For example, you could create a Conference that will allow your local phones to dial 800, and then
enter into a conference call.

Figure 2-2-25 Conference interface

Conference m

Basic

Conference Number
Conference Name

User PIN

Admin PIN

Below a description of each parameter:

Table 2-2-22 Definition of add Conference

Item Definition
Basic
Conference Number Use this number to dial into the conference.
Conference Name Give this conference a brief name to help you identify it.
User PIN You can require callers to enter a password before they can enter this conference.

This setting is optional.
If either PIN is entered, the user will be prompted to enter a PIN.
Admin PIN Enter a PIN number for the admin user.

This setting is optional unless the ‘leader wait’ option is in use, then this PIN will

identify the leader.

Advanced
Join Message Message to be played to the caller before joining the conference.
To add additional recordings use the “System Recordings” MENU to the left

Leader Wait Wait until the conference leader (admin user) arrives before starting the

conference
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Talker Optimization Turn on talker optimization. With talker optimization, Asterisk treats talkers who
are not speaking as being muted, meaning that no encoding is done on
transmission and that received audio that is not registered as talking is omitted,
causing no buildup in background noise.

Talker Detection Sets talker detection. Asterisk will sends events on the Manager Interface
identifying the channel that is talking. The talker will also be identified on the
output of the meetme list CLT command.

Quiet Mode Quiet mode (do not play enter/leave sounds)

User Count Announce user(s) count on joining conference

User join/leave Announce user join/leave

Music on Hold Enable Music on Hold when the conference has single caller

Music on Hold Class Music (or Commercial) played to the caller while they wait line for the
conference to start. Choose “inherit” if you want the MoH class to be what is
currently selected, such as by the inbound route.

This music is defined in the “Music on Hold” to the left.
Allow Menu Present Menu (user or admin) when “*’ is received (‘send’ to menu).

Record Conference

Record the conference call

Maximum Participants

Maximum Number of users allowed to join this conference.

Mute on Join

Mute everyone when they initially join the conference. Please note that if you do
not have ‘Leader Wait’ set to yes you must have ‘Allow Menu’ set to Yes to

unmute yourself.

3.4.7 Callback

Callback is where you make a call to your IP-PBX and when reached you will be disconnected, but it
does not end there. Your PBX will in turn call your mobile and reconnect you relieving you of the
cost of the lengthy Mobile phone call that you will otherwise be up for.

Let’s take this step by step.

1. Setup DISA

Call Features
WR
Queues

Phonebook

DISA

a. DISA name: MyMobile
b. Response Timeout: 10
c. Digit Timeout:5
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d. Caller ID:0400123456 (My Mobile Number)
e. Context: from-internal

Figure 2-2-28 Set on DISA
DISA =

Basic

DISA name

MyMobile

PIN

Response Timeout

10

Digit Timeout
5

Require Confirmation OFF

Caller ID

0400123456

Context

from-internal

Allow Hangup OFF

Caller ID Override

Enable

Click Save button.
2. Setup Callback

Call Features
MR

Clueues

Phonebook

DISA

Conference

Callback

a. Callback Description: My Mobile

b. Callback Number: 0400123456 (My mobile Number)

c. Delay Before Callback:10

d. Destination after Callback: IVR — Residence (or Office IVR)
Figure 2-2-29 Callback interface
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Callback m

Basic

Callback Description
MyMobile
Callback Number

0400123456

Delay Before Callback

10

Destination

IVR v

Null v

Click Save button

3. Inbound Routes

a. Description: Callback-MyMobile

b. DID Number:61247324100 (My DID number)

c. Caller ID Number: 0400123456 (My mobile Number)
d. Set Destination to: Callback — MyMobile

Inbound Routes m

Basic Advanced

Description
Callback-MyMobile

DID Number

61247324100

CallerlD Number

0400123456

Click Save button then Click on the red circle at the top & follow on screen prompts

Now enable send caller ID on your mobile and call your DID number. When connected you will get
one beep and then followed by silence. Hang up your mobile and wait for approximately10 seconds
and your mobile will ring.
When you answer your mobile, you will hear your IVR playing with the various options. One of the
silent options in my IVR is DISA. If I need to make an external call using my PBX. If I know the
option and select it, I will be then get DISA where I can make an external call at no cost to my
Mobile.

Table 2-2-23 Definition of add Callback
Item Definition

Callback Description | Enter a description for this callback

Callback Number Optional: Enter the number to dial for the callback. Leave
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this blank to just dial the incoming CallerID Number.

Delay Before Optional: Enter the number of seconds the system should
Callback wait before calling back.
3.4.8 Parking Lot

Figure 2-2-30 Parking Lot interface

Parking Lot m

Basic Advanced

Parking Lot Extension

70

Parking Lot Name

Default Lot

Parking Lot Starting Position

Number of Slots

4
(71-74)

Parking Timeout (seconds)

45

Parked Music Class

default A

This module is used to configure Parking Lot(s) in Asterisk.
Simply transfer the call to said parking lot extension. Asterisk will then read back the parking lot
number the call has been placed in. To retrieve the call simply dial that number back.

Table 2-2-24 Example usage of Parking Lot
*2nn: | Attended Transfer call into Park lot nnn
(It will announce the slot back to you)

nn: Park Yourself into Parking lot nnn
(Announcing your parked slot to you)

3.4.9 Voicemail Blasting

Voicemail blasting lets you send a voicemail message to multiple users at the same time. The
Voicemail Blasting module is used to create a group of users and assign a number to the group. A
user can dial this number to leave a voicemail message for the group. All members of the group will
receive the message in their voicemail boxes.
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Figure 2-2-31 Voicemail Blasting interface

VoiceMail Blasting m

Basic

VMBlast Number
500

Group Description

Audio Label

Read Group Number T

Optional Password

Voicemail Box List
Available Selected

Default VMBlast

Group ©AF

Table 2-2-25 Definition of add VMBIlast Group
Item Definition

VMBIlast Number | The number users will dial to voicemail boxes in this VMBIlast group

Group Description | Provide a descriptive title for this VMBIlast Group.

Audio Label Paly this message to the caller so they can confirm they have dialed the proper
voice mail group number, or have the system simply read the group number.

Optional Password | You can optionally include a password to authenticate before providing access
to this group voicemail list.

Voicemail Box List | Select voice mail boxes to add to this group. Use Ctrl key to select multiple.
Default VMBlast Each PBX system cam have a single Default VOICEMAIL Blast Group. If
Group specified, extensions can be automatically added (or removed) from this default
group in the Extensions (or Users) tab.

Making this group the default will uncheck the option from the current default
group if specified.

3.4.10 Paging and Intercom

The Paging and Intercom module is used to set up an extension number that your users can dial in
order to place an intercom call to multiple phones on your system at the same time.

For example, in a small office, you might set up a page group with extension number "100." When
100 is dialed by a local user, all of the phones in the office would go off-hook, and you could speak
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to everyone at every extension at the same time. Alternatively, you could set up page groups with
different extension numbers for each department in the office, i.e. 100 for sales, 110 for service, and
SO0 on.

Figure 2-2-32 Paging and Intercom interface

Paging and Intercom m

Basic

Paging Extension
Group Description

Device List
Not Selected Selected

101 -101 -
102-102
103-103
104-104
105-105
106-106
107 -107 h

Busy Extensions

Skip v

Duplex OFF

Default Page

Group .17

This module is for specific phones that are capable of Paging or Intercom. This section is for
configuring group paging, intercom is configured through Feature Codes. Intercom must be enabled
on a handset before it will allow incoming calls. It is possible to restrict incoming intercom calls to
specific extensions only, or to allow intercom calls from all extensions but explicitly deny from
specific extensions.

This module should work with Aastra, Grandstream, Linksys/Sipura, Mitel, Polycom, SNOM , and
possibly other SIP phones (not ATAS). Any phone that is always set to auto-answer should also work
(such as the console extension if configured).Intercom mode is currently disabled, it can be enabled
in the Feature Codes Panel.

3.5 Voice Prompts

3.5.1 Languages

The Languages module is used to allow calls to be routed to localized or alternate language
recordings.
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Figure 2-2-33 Languages interface

Languages m

Basic

Description

Language Code

FR v

Destination

== choose one == v

Languages allow you to change the language of the call flow and then continue on to the desired
destination. For example, you may have an IVR option that says "For French Press 5 now". You
would then create a French language instance and point it's destination at a French IVR. The
language of the call's channel will now be in French. This will result in French sounds being chosen
if installed.

Table 2-2-26 Definition of add Language

Item Definition
Description The descriptive name of this language instance. For example, “French Main [VR”
Language Code The Asterisk language code you want to change to. For example, “fr” for French.

3.5.2 System Recordings

The System Recordings module is used to record or upload messages that can then be played back to
callers in other modules. It can also be used to make pre-installed Asterisk recordings available for
use in other modules.

For example, you might create a recording called "Main Menu" and then play that message in an
IVR before a caller is asked to make a selection. Or, you might record a recording called "Holiday
Message" and then use that message in an Announcement. You would then route incoming calls to
the Announcement or IVR using the Inbound Routes Module.

Figure 2-2-34 System Recordings interface

System Recordings

Add Recording Built-in Recordings m W Delete n

Type Hostname
3 2

4 test

5 welcome
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System Recordings

Record or upload

— If you wish to make and verify recordings from your phone, please enter your extension number here
Extensions v ==choose== v ﬂ
— Alternatively, upload a recording in any supported asterisk format. Note that if you're using .wav, (eg, recorded with Microsoft Recorder) the file must be PCM Encoded, 16 Bits, at 8000Hz
Choose File | No file chosen Upload
Name

Name this Recording

— Click "SAVE™ when you are satisfied with your recording

Save

3.5.3 Announcement

The Announcements Module is used to create a destination that will play an informational message
to a caller. After the message is played, the call will proceed to another destination.

For example, you might create an Announcement that plays the address, fax number, and the
web-site of your business. A caller could reach that message by pressing the number 2 from the
company's main menu. After hearing the message, the call might be routed back to the company's
main menu and allowed to make another selection.

Figure 2-2-35 Announcements interface

Announcement
Basic
Name
test
Recording
test v

Repeat button

Disable v

Allow Skip m

Return to IVR OFF

Don't Answer Channel OFF

Destination

Custom Destinations v

Query Current IP v

Table 2-2-27 Definition of Announcements

Item Definition

Name The name of this announcement
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Recording

Message to be played.
To add additional recordings use the “System Recordings” MENU to the left

Repeat

Key to press that will allow for the message to be replayed. If you choose this option
there will be a short delay inserted after the message. If a longer delay is needed it should
be incorporated into the recording.

Allow Skip

If the caller is allowed to press a key to skip the message

Return to IVR

If the announcement came from an IVR and this box is checked, the destination below
will be ignored and instead it will be return to the calling IVR. Otherwise, the destination
below will be taken. Don’t check if not using in this mode.

The IVR return location will be to the last IVR in the call chain that was called so be
careful to only check when needed. For example, if an IVR directs a call to another
destination which eventually calls this announcement and this box is checked, it will
return to that [IVR which may not be the expected behavior.

Don't Answer
Channel

Check this to keep the channel from explicitly being answered. When checked, the
message will be played and if the channel supports that. When not checked, the channel
is answered followed by a 1 second delay. When using an announcement from an IVR or
other sources that have already answered the channel, that 1 second delay may not be

desired.

3.5.4 Route Congestion Messages

Route Congestion

Basic

Figure 2-2-36 Route Congestion Messages interface

No Routes Available

Standard Routes

Default Message

Intra-Company Routes

Default Message

Emergency Routes

Default Message

Trunk Failures

Default Message

Number or Address Incomplete

Default Message

OpenVox Communication Co. , LTD.
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Table 2-2-28 Definition of Route Congestion Messages

Item ‘ Definition
No Routes Available
Standard Routes Message or tone to be played if no trunks are available.
Intra-Company Message or tone to be played if no trunks are available. Used on routes marked as
Routes intra-company only.

Emergency Routes | Message or tone to be played if no trunks are available. Used on all emergency routes.
Consider a message instructing caller to find an alternative means of calling emergency
services such as a cell phone or alarm system panel.

Trunk Failures

No Answer Message or tone to be played if there was no answer. Default message is: “The number is
not answering." Hangupcause is 18 or 19

Number or Message or tone to be played if trunk reports Number or Address Incomplete. Usually this

Address means that the number you have dialed is to short. Default message is: “The number you

Incomplete have dialed is not in service. Please check the number and try again."Hangupcause is 28
3.5.5 Music On Hold

The volume adjustment is a linear value. Since loudness is logarithmic, the linear lever will be less of
an adjustment. You should test out the installed music to assure it is at the correct volume. This
feature will convert MP3 files to WAV files. If you do not have mpg123 installed, you can set the
parameter: Convert Music Files to WAV to false in Advanced Settings.

Figure 2-2-37 Music on Hold Interface

Music On Hold

Upload a .wav or .mp3 file B Browse

Volume Adjustment

Volume 100% T
Enable Random Play
fpm-calm-river.wav =]
fpm-world-mix.wav =
fpm-sunshine.wav @
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3.6 Settings

3.6.1 Global Settings

Global Settings

Basic Device Settings Dialplan and Operational Features Settings

Asterisk Manager

Asterisk Manager Password 111111 2

Asterisk Manager User

admin
System Setup
Aggresively Check for Duplicate Extensions @ True ® False
User & Devices Mode extensions v
Call Recording Format way -]
Convert Music Files to WAV ® True O False
Voice Prompts
Default language en -

Refresh Page

3.6.2 Analog Settings
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General

Tone duration

100

Codec

Ulaw

Impedance

Sweden
Echo
Cancellation
EC Taps

1024

Flash/\Wink ON
Min flash time

40

Max flash time

400

"#" as Ending -
Dial Key oF
Hangup on

. . OFF
polarity switch

Figure 2- 2-38 general Configuration

Table 2-2-29 Instruction of General

Options

Definition

Tone duration

How long generated tones (DTMF and MF) will be played on the channel.

(in milliseconds)

Codec Set the global encoding: mulaw, alaw.
Impedance Configuration for impedance.
Flash/Wink Turn on/off Flash/wink.

Min flash time

Min flash time.(in milliseconds).

Max flash time

Max flash time.(in milliseconds).

Key

“#’as Ending Dial

Turn on/off Ending Dial Key.

switch

Hang up on polarity

Turn on/off Hangup on polarity switch

OpenVox Communication Co. , LTD.
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Figure 2-2-39 Hardware gain

Hardware gain

FX3 Rx gain
0 L
FX5 Tx gain
0 L
FX0 Rx gain
0
FX0O Tx gain
0
Table 2-2-30 Instruction of Hardware gain
Options Definition
FXO Rx gain Set the FXO port Rx gain. Range: from -150 to 120.
FXO Tx gain Set the FXO port Tx gain. Range: from -150 to 120.
FXS Rx gain Set the FXS port Rx gain. Range: -35, 0 or 35.
FXS Tx gain Set the FXS port Tx gain. Range: -35, 0 or 35.
Figure 2-2-40 Fax
Fax

Maximum Transmission Rate

14400

Minirmum Transmission Rate

14400

Ecm m

Table 2-2-31 Definition of Fax
Options Definition
Maximum Transmission Rate | Set the maximum transmission rate
Minimum Transmission Rate | Set the minimum transmission rate
Ecm Enable/disable T.30 ECM (error
correction mode) by default.
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Send CallerlD

The pattern of sending CID

send CID after first ring

Figure 2-2-41 Send Caller ID

Waiting time before sending CID

100

Send polarity

reversal(DTMF OFF

Only)
Start code(DTMF Only)

Stop code(DTMF Only)

Table 2-2-32 Instruction of Send Caller ID

Option

Description

The pattern of sending
CID

Some countries(UK) have ring tones with different ring
tones(ring-ring), which means the caller ID needs to be set
later on, and not just after the first ring, as per the
default(1).

Waiting time before

How long we will waiting before sending the CID on the

sending CID channel. (in milliseconds).

Sending polarity Send polarity reversal before sending the CID on the
reversal(DTMF Only) channel.

Start code(DTMF Only) | Start code.

Stop code(DTMF Only) | Stop code.

OpenVox Communication Co. , LTD.
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Figure 2-2-42 CallerID Detection

CalleriD Detection

Use Callerid ON

Hide Callerid OFF
Callerid

asreceived v
CID Signalling

bell T
CID Start

ring A
Handle
Irreqular CID orF

CID Buffer Length

3000

Cut CID Buffer Head Length

128

Fixed Time Polarity

-1

CID Timeout

6000

Table 2-2-33 Instruction of CallerID detect

Options Definition
Use Callerid Turn on/off callerid detect function
Hide Callerid Turn on/off callerid detect function
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Country

Country

China

Dial tone

450

Busy tone

450/350,0/350

Congestion tone

450/700,0/700

Record tone

950/400,0/10000

Ring cadence

10004000

Ring tone

450/1000,0/4000

Call waiting tone

450/400,0/4000

Dial recall tone

450

Info tone

Figure 2-2-43 Country

450/100,0/100,450/100,0/100,450/100,0/100,450/400,0/400

Stutter tone

450+425
Table 2-2-34 Definition of Country
Options Definition
Country Configuration for location specific tone indications.
Dial tone Set of tones to be played when one picks up the hook.
Busy tone Set of tones played when the receiving end is busy.

Congestion tone

Set of tones played when there is some congestion.

Record tone

Set of tones played when call recording is in progress.

Ring cadence

List of durations the physical bell rings.

Ring tone

Set of tones to be played when the receiving end is ringing.

Call waiting tone

Set of tones played when there is a call waiting in the background.

Dial recall tone

Many phone systems play a recall dial tone after hook flash.

OpenVox Communication Co. , LTD.
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Info tone Set of tones played with special information messages (e.g., number is out of service.)
Stutter tone

Figure 2-2-44 Silence detect

Silence detect
Silence detect OFF
Silence threshold
250
Silence length

300

Silence framesize

1024

Table 2-2-35 Definition of Silence detect

Options Definition

Silence detect Turn on/off silence detect function

Silence threshold What we consider silence: the lower, the more sensitive, eg:250 is
250ms. Range: 100 to 500(100 to 500ms), default: 250

Silence length How many silence threshold of silence before hanging up(eg: 16 is
250ms*16=4s). Range: 2 to 1020 (200ms to 512s), default: 80(20s)

Silence Rx threshold Range:-20 dBmO to -40 dBm0, default: 20(-20 dBmO0), all values are

framesize understood to be negative.

Tx threshold Range:-20 dBmO to -40 dBm0, default: 20(-20 dBmO0), all values are

understood to be negative.

Figure 2-2-45 Special tone

Special tone

Custom Busy

OFF
Tone detect
Busy Tone count: 3
Busy Tone pattern: 450/350,0/350

Add New Busy Tone Pattern

Table 2-2-36 Instruction of Special tone

Options Definition

Custom Busy Tone detect | Turn on/off busy detect function
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Busy Tone count How many busy tones to wait for before hanging up. The
default is 3, but it might be safer to set to 6 or even 8.

Busy Tone pattern Set the busy detect country

3.6.3 RTP Settings

RTP Settings

Basic

Strict RTP RTP Checksums ICE Support
RTP Start

10000

RTP End

20000

Reinvite Behavior

Yes

RTP Time Out

60

RTP Hold Time Out

300

RTP Keep Alive
0

STUN Server

TURN Server

TURN Server Name

TURN Server Password

OpenVox Communication Co. , LTD.
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3.6.4 IAX2 Settings

IAX2 Settings

Audio Codecs Jitter Buffer Settings

Codec Priority

host

Bandwidth

unset

Video Support

Disabled

Audio Codecs

Figure 2-2-52 Audio Codecs

Advanced General Settings

Available Selected
siren? ulaw
gr22 gsm
siren14 alaw
amr
amrwh
speex
opus v

Table 2-2-43 Audio Codecs
Options Definition

Asterisk: codecpriority. Controls the codec negotiation of an inbound IAX call. This option is inherited to all
user entities. It can also be defined in each user entity separately which will override the setting here. The valid

Codec values are:host - Consider the host's preferred order ahead of the caller's.caller - consider callers host's. disabled

Priority disable consideration codec preference altogether. (this is original behavior before preferences were
added)reqonly same as disabled, only do not capabilities if requested format available call will be accepted
available.

Bandwidth | Asterisk: bandwidth. Specify bandwidth of low, medium, or high to control which codecs are used in general.

Video Check to enable and then choose allowed codecs. If you clear each codec and then add them one at a time,

Support submitting with each addition, they will be added in order which will effect the codec priority.

Audio Check the desired codecs, all others will be disabled unless explicitly enabled in a device or trunks

Codecs configuration. Drag to re-order.

OpenVox Communication Co. , LTD.
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Figure 2-2-53 Jitter Buffer Settings

Registration Settings

Registration Times 60 (minregexpire) 3600 (maxregexpire)

Jitter Buffer Settings

Jitter Buffer
Disabled ¥
Table 2-2-44 Jitter Buffer Settings
Options Definition
Registration Settings
Registration Asterisk: minregexpire, maxregexpire. Minimum and maximum length of time that IAX peers can
Times request as a registration expiration interval (in seconds).
Jitter Buffer Settings
Asterisk: jitterbuffer. You can adjust several parameters relating to the jitter buffer. The jitter
Jitter Buffer buffer’ s function is to compensate for varying network delay. the jitter buffer works incoming
audio - outbound will be dejittered by at other end.
Figure 2-2-54 Advanced General Settings
Language

Bind Address

Bind Port

Delay Auth Rejects

Enable

Other IAX Settings =

Add Field

Table 2-2-45 Advanced General Settings

Options

Definition
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Language Default Language for a channel, Asterisk: language
Asterisk: bindaddr. The IP address to bind to and listen for calls on the Bind Port. If set to 0.0.0.0
Bind Asterisk will listen on all addresses. To bind to multiple IP addresses or ports, use the Other iax
Address settings' fields where you can put settings such as:bindaddr='192.168.10.100:4555." it is
recommended to leave this blank.
Asterisk: bindport. Local incoming UDP Port that Asterisk will bind to and listen for IAX messages.
Bind Port The IAX standard is 4569 and in most cases this is what you want. It is recommended to leave this
blank.
Delay Auth | Asterisk: delayreject. For increased security against brute force password attacks enable this which
Rejects will delay the sending of authentication reject for REGREQ or AUTHRERP if there is a password.
You may set any other IAX settings not present here that are allowed to be configured in the General
Other IAX | section of iax.conf. There will be no error checking against these settings so check them carefully.
Settings They should be entered as: [setting] = [value]in the boxes below. Click the Add Field box to add

additional fields. Blank boxes will be deleted when submitted.

3.6.5 Functions Code

The Feature Codes Module is used to enable and disable certain features available in your PBX and
Asterisk, and to set the codes that local users will dial on their phones to use that particular feature.

For example, the Feature Codes Module can be used to set the code that a user will dial to activate or
deactivate Call Forwarding. It can also be used to set a Code that can be used to enter into an Echo
Test, to hear your extension number, or to hear the time of day.

Basic

Figure 2-2-55 Feature code admin interface

Use Feature
Default? Status
Blacklist
Blacklist a number =30 m Enabled v
Blacklist the last caller =32 m Enabled A
Remove a number from the blacklist =31 m Enabled A
Call Forward
Call Forward All Activate =72 m Enabled v
Call Forward All Deactivate =73 m Enabled A
Call Forward All Prompting Activate =720 m Enabled v
Call Forward All Prompting Deactivate =74 m Enabled v
Call Forward Busy Activate el m Enabled v
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3.6.6 Misc Destinations

The Misc Destinations Module is used to create a miscellaneous destination to which you can route
calls from another module.

For example, you might create a misc destination called "My Mobile Phone" that dials your mobile
telephone number. Then, you could set up an IVR so that if a caller presses 9, they would be routed
to "Misc Destinations:My Mobile Phone."

Misc Destinations are for adding destinations that can be used by other FreePBX modules, generally
used to route incoming calls. If you want to create feature codes that can be dialed by internal users
and go to various destinations, please see the Misc Applications module. If you need access to a
Feature Code, such as *98 to dial voicemail or a Time Condition toggle, these destinations are now
provided as Feature Code Admin destinations. For upgrade compatibility, if you previously had
configured such a destination, it will still work but the Feature Code short cuts select list is not
longer provided.

Figure 2-2-56 Misc Destinations interface

Misc Destinations m
@
Description
Dia
Ring Time {max 300 sec)

20

Table 2-2-46 Definition of add Misc Destination

Item Definition
Description Give this Misc Destination a brief name to help you identify it.
Dial Enter the number this destination will simulate dialing, exactly as you would dial it

from an internal phone. When you route a call to this destination, it will be as if the

caller dialed this number from an internal phone.
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3.6.7 PJSIP Settings

PJSIP Settings

Basic Transports

Misc PJSip Settings
Allow Guests

No

Domain the transport comes from

External IP Address

Local network

3.6.8 AMI

AMI

Basic

Manager name

Manager secrat

Deny

0.0.0.0/0.0.0.0

Permit

127.0.0.1/255.255.255.0

Read Write

system
verbose
user
dtmf

dialplan
ALL

OpenVox Communication Co. , LTD.

Read Write

call

command

config

reporting

originate

Figure 2-2-58 Add AMI User interface

Read Write

log

agent

cdr

message
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Figure 2-2-58 AMI Settings interface

Av 3

Basic

Manager name
Manager secret

Deny
0.0.0.0/0.0.0.0

Permit

127.0.0.1/255.255.255.0

Read Write Read Write Read Write
system call log
verbose command agent
user config
dimf reporting cdr
dialplan originate message
ALL
.
3.7 Recording

3.7.1 Call Recordings

The option "Calls Recordings" of the Menu "Recordings™ in UC series lets us view a list with details
of all recorded calls for the extension associated to the connected user. The administrator account can
see all the recordings.

Figure 2-2-59 Calls Recordings interface

Calls Recordings
LEETE | & Download | Start Date | 06 May 2019 | End Date | 06 May 2019 Search | Source v E m

Date Time Source Destination Duration Message

No records match the filter criteria

3.7.2 VoiceMails
The option "Voicemail" of the Menu “Recordings” in UC series lets us view a list with details of the
voicemails for the extension of the logged user.
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Figure 2-2-60 Voicemails interface

Calls Recordings

& Download |~ Start Date | 06 May 2019 End Date | 06 May 2019 Search Source v &) m

Date Time Source Destination

No records match the filter criteria

The report will change depending on the values of the filter:

VoiceMails

Configuration Start Date | 06 May 2019 End Date | 06 May 201p

- May 2019

Date Time CalleriD
Mo Tu We

29 30 1
B
1314 15
20 21 2

27 28 29

Today

Table 2-2-49 Definition of Show Filter

Parameter | Description

Th
2
9

16

23

30

Fr

Duration Message

-
Duration

Su
5 ilter criteria

26

Start Date | Start date for the selection of voicemails.

End Date |End date for the selection of voicemails.

To delete a voicemail, just select the voicemail from the list and click on "Delete™ button.

3.7.3 VoiceMails Admin

The option "Voicemail Admin" of the Menu “Recordings” lets us view or modify some voicemail

configuration.

Figure 2-2-61 Voicemails Admin interface

VoiceMails Admin

Dialplan Behavior m Timezone Definitions

MName

OpenVox Communication Co. , LTD.

Status

(disabled)
(disabled)
(disabled)
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3.8 Tools

3.8.1 Operator Panel

The option "Operator Panel" of the menu "Tools" in UC series allows managing the telephony
operations. You can control inbound calls, outbound calls, the order in which the calls are taken, the
area that is designated to attend a call, etc.

This module is useful for receptionists who have a general view of the queues, conferences, parking
lots, internal extensions, trunks. Here the receptionist can start a call or transfer a call by dragging
one extension to another, or include several extension to a conference room, or a queue. The
receptionist can also see the busy extensions, the elapsed time and the caller ID.

Figure 2-2-62 Operator Panel interface

Operator Panel

Extensions

101 g [ 102 g [103 g [104 % [10s . [106 [ 107 g [108 G
101 102 103 104 105 106 107 108

109 [0 Q

109 10

FXO/FXS Trunks

FXS1 FXS/2 FXO/3 00 FXO/4 00

SIP/IAX Trunks

PJSIPlisp

Conferences

Parking lots

Parked (71) . Y Parked (72) , Y Parked (73) , Y Parked (74) -

Queues

®
123: 123 P

3.8.2 WebRTC

WebRTC is a new feature. You can use any web browser that supports WebRTC to register an
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extension number to your UC series system without any plugins.

To register the extensions used for WebRTC please follow the steps below:

Step 1:

Create a SIP Extension

To create a extension, navigate to PBX > Extensions > Extensions. Click on “Add” button to add a
new sip extension.

Step 2:

Configure the SIP Extension and Settings

As you can see, these extensions use different protocols for signaling and media (WS/WSS) and they
are not ordinary SIP extensions that can use IP phones or softphone to register so must be treated
differently. There are some options that are supposed to be changed of extensions as follows:

Transport
WSS Only v
Avpf
es v
lcesupport
es v
Dtlsenable
Yes v
Encryption
Yes (SRTP only) T

Besides, some configurations on the sip settings page are as follows:
IP Configuration

Public IP v
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Audio Codecs

Available Selected

speex o~ .
- ulaw

07263al2 » gem
TH =
fllinLS > __Alaw
o729 |
ilbc L4
adpcm
gr23 L
Ipc10 h

Video Codecs

Available Selected
h263p "
h263 L )
h261
h264 >
£
L,

Video Support

Enabled v

Step 3:

Register a Web Extension

After completing the process above you can access the WebRTC extension register interface.
Navigate to PBX > Tools > WebRTC, you will see the web extension register interface.

Please complete the register credentials as below:

WOWhpnont

WOWPHONE

Name i.e. Homer Simpson

SIP URI i.e. siphomer@your-domain.com

101@172.16.208.33

SIP Password

WS URI i.e. wss:/iyour-domain.com:8089/ws

wss://172.16.208.33:8089/ws

advanced settings

(Note:172.16.208.33 should be your IPPBX IP address)

Next, press Login and the web extension will be registered and is ready for phone calls just like any
other standard extension.

WebRTC can even be adapted to an enterprise website which can help an enterprise serve their
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customers with direct voice communication via their website. For more advanced WebRTC

settings please refer to the WebRTC manual.

3.8.3 Asterisk-Cli

The option “Asterisk-Cli” of the Menu “Tools” in UC series lets us execute Asterisk commands.

Figure 2-2-64 Asterisk-Cli inte

Basic

Command | pjsip show endpoints

rface

Endpoint: <Endpeint/TID. . ... . .. i * «<State..... ¢Channels. »
TA0buth:  ChuthTd MserFame. ..o i
Bor:  Chor. .. »  MaxContactk
Contact: Chor/TontactUri.. ... .. ... ... ... ........ » ¢Hash. ... » <Status> ¢EIT(ms)..>
Transport: <TranspertId ... ... > Iyper <eos> Ctos» <BindAddress. .. ... . . ... E
Tdentify: <Tdentifw/Endpoinmt. .. ... . ... »
Mateh: Ceriteria. . ... .. ... ... ... .. .. ... >
Charmel: ChanmelTd ... .. .. ... . ... L » <State. .. .. cTime. . ... 3
Exten: <DialedBxten........... » CLCID: <ConnectedlineCID. ... ... >
Endpoint: 1017101 Unavailable 0O of inf
Irduth:  101-anth 101
bor: 101 5
Transport: 0.0.0.0—udp udp u] 0 0.0.0 0:5060
Endpoint: 1025102 Tnavailable 0 of inf
Infuth:  10Z2-auth/102
hor: 102 1
Endpoint: 1035103 Tnavailable 0 of inf
Intuth:  103-auth/103
hor: 103 1
Endpoint: 104/104 Tnavailable 0O of inf
Inhuth: 104-anth/104
hor: 104 1
Endpoint: 105/108 Unavailable 0 of inf
Ioduth:  105-auth 105
bor: 108 1
. ) . Execute
To execute a command, input the same in the Command field and click on the button.

3.8.4 Asterisk File Editor(developer mode)

The module "Asterisk File Editor" of the Menu "Tools" in UC series lets us edit easily the
configuration files of UC series, while you have to enter the developer mode before use it. The path

of the files you can modify is /etc/asterisk/.

OpenVox Communication Co. , LTD.
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Figure 2-2-65 Asterisk File Editor interface

Asterisk File Editor

Page [T of10mM
m File: @) | Filter
File Name File Size
acl.conf 2816
additional_a2billing_iax conf 0
additional_a2billing_sip.conf 0
adsi.conf 140
agents.conf 2531
alarmreceiver.conf 2084
allogsm-channels.conf 1078
alsa.conf 3504
amd.conf 851
app_mysal.conf.sample 1044
app_skel.conf 338
asterisk adsi 3254
asterisk conf 385
backup 1024
calendar conf 5171
cbmysql.conf 361
ccss.conf. 8827
cdr.conf 8724
cdr_adaptive_odbc.conf 2580
cdr_custom.conf 1617

Editing a file

You can find a file by entering the name in the filter field. To edit the file, click on the name to go to

the edit mode. Click on "Save" button to save changes and "Reload Asterisk" if necessary.

Figure 2-2-66 Editing a file interface

Asterisk File Editor

Basic

File| extensions.conf

; Do NOT edit this file as it is auto-generated by FreePBX. All modifications to
: this file must be done via the web gui. There are alternative files to make
. custom modifications, details at- http://freepbx org/configuration_files

; AUTO-GENERATED AND CUSOTM USER DIALPLAN INCLUDED HERE *

; Customizations to this dialplan should be made in extensions_custom.conf
. See extensions_custom.conf.sample for an example

; If you need to use [macro-dialout-trunk-predial-hook], [ext-did-custom], or
; [from-internal-custom] for example, place these in this file or they will get ovenwritten.

- WARNING ABOUT: #include extensions_override_freephx conf
#include extensions_room conf

. This include file is put first to allow the auio-generaied dialplan in FreePEX

; to be overwritten if necessary. Qverriding auto-generated dialplan should be done

; with extreme caution. In almest all cases any custom dialplan SHOULD be put in

; extensions_custom.conf which will not hurt a FreePBX generated dialplan. In some
; very rare and custom situations users may have a need 1o override what FreePBX
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Creating a file

Also you can create a new file by clicking on "New File" button. This file will be created with the

extension ".conf" in /etc/asterisk/.

Asterisk File Editor

Basic

File Lconf

385 AITTS

Figure 2-2-67 Create a file interface

T T

Text can be converted to audio in the "AI TTS" function module. The output format of this file can
be ".wav". Write the information you want to convert, select the output format, and click the
"Generate Audio File" button. The system will automatically save the file to the location of your hard

drive as you requested.

AITTS

Basic Usage

File Name
File Description

Format
way
Language Locale

English (United States)
Voice Type
Advanced

Language Encoding

en-Us

Voice Name

en-US-Advanced-A

SSML Gender
MALE

OpenVox Communication Co. , LTD.

Figure 2-2-68 Text to Wav interface
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4 Fax

4.1 Virtual Fax

4.1.1 Virtual Fax List

The option “Virtual Fax List” of the Menu “FAX” in UC series lets us verify the list of all the virtual
faxes, including the status of each one.

Figure 2-4-1 Virtual Fax List interface
Virtual Fax List

Virtual Fax Name Fax Extension Secret Associated Email Caller ID Name Caller ID Number Status

1001 1001 phix1001 1001@openvox.cn 1001 1001 Running and idle on ttylAX3

Also, clicking on the virtual fax's name displays its information:
New Virtual Fax Edit

Basic

Virtual Fax Name

1001

Fax Extension (1AX)
1001

Associated Email
1001@openvox.cn

Secret (JAX)
pbx1001

Caller ID Name

1001

Country Code

0z6

Caller ID Number

1001

Area Code

0755
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Here you can Edit and Delete the Virtual Fax.

4.1.2 New Virtual Fax

The option “New Virtual Fax” from the Menu “FAX” in UC series lets us create a new virtual fax.
You should have previously created an IAX extension in "PBX => Extensions =>Add [AX2
Extension".

Figure 2-4-2 New Virtual Fax

New Virtual Fax m

Basic

Virtual Fax Name *
1001 B
Fax Extension (IAX)"
1001
Associated Email*
1001@openvox.cn
Secreat (IAX)*
gbﬂ1001
Caller ID Name

1001

Country Code*

086

Caller ID Number

1001

Area Code®

0755

To create a new virtual fax, enter the name, e-mail, extension, secret code, country code and area
code for the virtual fax (these are the mandatory fields). After this information is added, click on the
“save” button to save the virtual fax.

4.1.3 Send Fax

The option "Send Fax" of the menu "Fax" in UC series allows sending faxes to one or more numbers.
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Here you can enter the text you want to send and click on “ button.

Figure 2-4-3 Send fax with text information

Send Fax

Basic

Fax Device to use *

100171001

Destination fax numbers”

501
(@ Text Information () File Upload

Text to FAX”

Hello
tesy

Also, you can send files in the format .pdf, .tiff and .txt

Figure 2-4-4 Send fax with File Upload

Send Fax

Basic

Fax Device to use *

1001 71001

Destination fax numbers®

501

() Text Information @) File Upload

Text to FAX® Types of files supported: pdf, tiff, txt

OpenVox Communication Co. , LTD.
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4.1.4 Fax Queue

The option "Fax Queue" from the Menu "FAX" in UC series shows the list of faxes that are awaiting
its turn to be sent. All the jobs have an ID and a status so you can monitor the sending of the faxes. If

you want to cancel a job, just select the job and click on button.

Figure 2-4-5 Fax Queue interface

Fax Queue
Job 1D Priority Destination Pages Retries Status
No records match the filter criteria
4.2 Fax Master

The option "Fax Master" of the Menu "FAX" in UC series lets us input the email address of the
administrator of the Fax, and this email will receive notifications of the messages received, errors
and other activities of the Fax Server.

Figure 2-4-6 Fax Master Interface

Fax Master m

Basic

Write the email address which will receive the notifications of received messages, errors and activity summary of the Fax Server

use I'@G penvox.cn

4.3 Fax Clients

The option "Fax Clients" of the Menu "FAX" in UC series lets us input the IPs that have permission

to send faxes through UC series.
Figure 2-4-7 Fax Client interface

Fax Clients m

Basic

localhost
127.0.0.1
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Proceed to input the IPs, one IP per line and click on the button.

It is recommended that you input the IP 127.0.0.1 and localhost in the configuration because some
processes might need to use them.

4.4 Fax Viewer

The option "Fax Viewer" of the Menu "Fax" shows a list with all the faxes that have been sent and
received in the virtual Faxes. You can download the faxes if you click on the name of the file.

Figure 2-4-8 Fax Viewer interface

Fax Viewer
DLIE M Company Mame [}]| Fax Date Company Fax Type Fax Al v Search
Type File Company Mame Company Fax Fax Destiny Fax Date Status Options

Mo records match the filter criteria

By the default all the files are shown, but you can filter according to company name, company fax,
fax date or type fax.
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5 Reports

5.1 CDR Report

The option "CDR Reports" of the Menu “Reports” in UC series lets us view a list with the details of
the calls. You can download this list in different format files such as CSV, XLS and PDF.
Figure 2-5-1 CDR Report interface

CDR Report
Delete X Download | = Start Date | 06 May 201¢ | End Date | 06 May 201¢ | Field: Call To v B m
Date Call From Ring Group Call To Src. Channel Account Code Dst. Channel Status Duration Message

No records maich the filter criteria

5.2 Channels Usage

The option "Channels Usage™ of the menu "Reports” in UC series lets us view graphically the
number of simultaneous calls for each channel.

Figure 2-5-2 Channel usage interface

Channels Usage

Simul taneous calls, memory and CPU
£00

ao0 F

200 — CPU uzage CH)
F — Mem. usage CMED

— Zim. calls

0 fore oot ety tntanbeny Aflrm ke g
= w =3 uw = uw = uw = uw =g
% = 58 5 = o i e = 8 B
o — o o 0 - E=3 oJ 0 " f=3
- [a¥) o E=3 =3 E=1 - - - - (¥ ]
Simultaneous DAHDI Channels
1.0

0.5
— [DOAHDI Channels I

0.0

18:140 T

21:15 |
23:50
02:25
05:00 -
0735
10:10 |-
12:45 |
15:20 |
17:55 |
20130 -

Simultaneous 5IP Channels
1.0

0.5

= 35IF Channels I

0.0

18140 T

21:15 |-
23:50
02:25 -
05100 -
0735
10:10 -
12:45 |
15:20 |
17:55 |-
20530 -
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5.3 Billing

5.3.1 Destination Distribution

The “Destination Distribution” option of the “Billing” Menu in UC series lets us view graphically
the distribution of the outgoing calls grouped by rate. The graph will change depending on the values
of the filter:

Figure 2-5-3 Destination Distribution interface

Billing

(G Destination Distribution

Start Date 27 Oct 2017 End Date 27 Oct 2017 Criteria Distribution by Time ¥

no message

Table 2-5-1 Definition of Destination Distribution

Name Description

Start Date The start date for calls to be selected.

End Date The end date for calls to be selected.
Criters Criteria for distribution: Distribution by Time, Distribution by Number of Calls, Distribution by
riteria
Cost.
5.3.2 Rates

The option "Rates” of the menu "Reports™ allows creating new rates and editing existing ones for
billing.

Figure 2-5-4 Rate interface
£ Billing Rates
Prefix Name Rate Rate Offset Hidden Digits Trunk Creation Date View

Default 05 10 ] * 2017-10-27 11:33.27 Wiew

To edit or delete a rate, click on the "View" link from the list
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Figure 2-5-5 View Rate interface

View Rate
Prefix: L] Rate (by min): $0.5 Creation Date: 2017-10-27 11:33:27
Name: Default Rate offset: $1.0 Trunk: = Hidden Digits: 0
Edit Cancel

Create a new Rate

You can create a new rate by clicking on button.

Figure 2-5-6 Create a new Rate interface

= New Rate

Basic

Prefix

Rate (by min}*($)

Hidden Digits*

0 v

Name*

Rate offset*(§)

Trunk*
Table2-5-2 Definition of Create a new Rate
Item Description
Prefix All the numbers that begin with this prefix will apply to this rate.
Name This is the name to identify the rate.
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Rate (by min) | This is the rate that will be apply to every single minute of consumption.
Rate offset This is the rate assigned for the connection.
Hidden Digits | This indicates the amount of digits you want to hide in the destination number.

Select the trunk that will apply for the rate. Make sure the trunk you want to

Trunk . : -
use is enabled. To check this, go to "Billing Setup™ module.
Click button to import a file into the system.
Figure 2-5-7 Import file interface
Billing
Import File v

Below a description of each parameter:

5.3.3 Billing Report

The option "Billing Report" in UC series shows a complete report of calls according to a rate
established in "Billing Rates". You can filter the results by date, rate applied, duration and so on.
Also you can download this report in different formats such as CSV, XLS and PDF.

Figure 2-5-8 Billing report interface

= Billing Report

W Select/Unselect All Date  Rate Applied RateValue  Source  Destination Dst. Channel  Account Code Duration Cost  Summary Cost

The fields in this report are:

Name Description

Date Initial date of call
Rate Applied |Name of Rate applied
Rate Value Rate value by minutes
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Source Number or source

Destination Destination Number

Dst. Channel |Channel Destination (Example: DAHDI/1)

Account Code | Code of account extension
Duration Duration in seconds of calls
Cost Cost of call

Summary Cost|Sum of all calls by cost field

5.3.4 Billing Setup

The option “Billing Setup” of the Menu “Billing” in UC series lets us determine the cost per minute
of the connection for the route by omission, and also determine which of the trunks will be used for

the billing process.

Figure 2-5-9 Billing setup interface

Billing / Billing Setup
Default Rate Configuration

Default Rate

0.50

Default Rate Offset

= Trunk Bill Configuration

DAHDI/g0

The list shows all of the registered trunks; you should select the ones that will be used for billing and

click on the “Billing Capable” button.

5.4 Graphic Report

The option "Graphic Report" of the "Reports" module allows visualizing graphically information
about the number of calls, queues and trunks of the system both in quantity and percentage.

OpenVox Communication Co. , LTD.
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Figure 2-5-10 Graphic report interface

Graphic Report

Start date: | 14 Nov 2018 d Etnd 06 May 2019 Trunk v PISIP/isp v m
ate:

To see the information of a specific extension, select "Extension (Number)" and then click on the
link "Here". In the pop-up window, choose the phone number and then click on "Show button".
Figure 2-5-11 Specific extension info

Start date: 14 Nov 2018 d:tr;? 06 May 2019 Extension (Number) A 101 m

Number of calls extension 101

o B Incoming Calls ©
B Outgoing Calls &

100¥

It is possible to generate a graphic of Number of Calls vs. Queues. To do this just select "Queue"
from the dropdown menu.
Figure 2-5-12 Queue record

Start date: 14 Nov 2018 End date: | 06 May 2019 Queue v

Mumber Calls ws. Queues
1.0

0.8 -
0.6
i B # Calls

0.4 -

0.2 -

0.0 : :

5.5 Summary

The option "Summary" of the menu "Reports" in UC series shows a report of each Extension
registered in the server. You can see the number of incoming and outgoing calls, the duration of the
calls, the caller id and the dialing number. Use the filter to find an extension or user.
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Summary

Start date
Extension v
101
102
103
104
105
106
107
108
109

110

User

10

102

103

104

105

106

107

108

109

110

End date

# Incoming Calls

0

Figure 2-5-13 Summary interface

Filter by Extension ¥ ] m

# Qutgoing Calls Total time (Incoming Calls) Total time (Outgoeing Calls) Details
0 00h. 00m. 00s 00h. 00m. 00s View
0 00h. 00m. 00s 00h. 00m. 00s View
0 00h. 00m. 00s 00h. 00m. 00s View
0 00h. 00m. 00s 00h. 00m. 00s View
0 00h. 00m. 00s 00h. 00m. 00s View
0 00h. 00m. 00s 00h. 00m. 00s View
0 00h. 00m. 00s 00h. 00m. 00s View
0 00h. 00m. 00s 00h. 00m. 00s View
0 00h. 00m. 00s 00h. 00m. 00s View
0 00h. 00m. 00s 00h. 00m. 00s View

Click on "View" to see more information of an extension.

No data to display

Figure 2-5-14 View extension info

Top 10 (Incoming) ext 1001

Top 10 {Outgoing) ext 1001

W 1002 (2 calls)

[ 0Other calls (0 calls)

OpenVox Communication Co. , LTD.
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5.6 Missed Calls

The option "Missed Calls" of the menu "Reports” in UC series shows a report of the missed calls of
all extensions so you can know when an extension has been receiving calls. You can download this
report by clicking on "Download" button. The available formats for this file are csv, xml and pdf

You can filter the results by:

e Start Date: Find missed calls from this date.

e End Date: Find missed calls until this date.

e Search : You can filter the results by these parameters:
o Source: Number that made the call.
o Destination: Number that received the call.

Figure 2-5-15 Missed calls interface

Missed Calls
& Download | = Start Date = End Date: = Search Source v [2] m
Date Source Destination Time since last call Mumber of attempts Status

Mo records match the filter criteria
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6. AddsOn

6.1 A2billing

A2billing is a full-featured, flexible VoIP billing system and terminal platform that provides the
fastest and lowest cost service for VoIP billing customers on the market today. This feature has been
added to the new UC, and users who need it can enter the account password to log in.

AUTHENTICATION

f:'_"" User: =
[ | Password: =
English r LOGIN

AZBilling 1.9.4 (Cuprum), A2Eilling is a voip billing software licensed under the AGPL 3
Copyright {C) 2004-2011 - StarZbilling 5.L. http://www.star2billing.com/

6.2 Video Conference

Users can create video conferences in UC501, allowing multiple people to participate at the same
time.

Video Conference

Server

Jitsi A

Room Mame

MsShESepzdb
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7 Logs

The option "Logs" of the "Reports" module allows visualizing the content of logs for monitoring the
events. You can filter the results by date or strings that are in the content of the logs.

7.1 Logs Settings

Figure 2-6-1 Logs Settings interface
Logs Settings m

System Logs

Auto Clean: m Max Size: 2MB ¥

DAHDI Logs

Enable: OFF Auto Clean: m Max Size: 2MB v

FXO Monitor Logs

Enable: OFF Auto Clean: m Max Size: 2MB v

L2TPVPN Client Logs

Enable: OFF Auto Clean: m Max Size: 2MB v

OPENVPN Client Logs

Enable: OFF Auto Clean: m Max Size: 2MB v

N2NVPN Client Logs

Enable: OFF Auto Clean: m Max Size: 2MB v
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7.2 System Logs

Figure 2-6-2 System Logs interface

System Logs

[[2019/04/23
[2019/04/23
[2019/04/23
[2019/04/23 17:
[2019/04/23 17:
[2019/04/24 09:
[2019/04/24 09:
[2019/04/24 09:
[2019/04/24 10:
[2019/04/24 10:
[2019/04/24 10:
[2019/04/24 10:
[2019/04/24 10:
[2019/04/24 10:

10:
16:
16:

45:15] Power on
:37] Power off
:29] Power on
:42] Power on
:08] Power on
:16] Power on
:57] Power on
:04] Power on
:33] Power off
:23] Power on
:12] Power off
:00] Power on
:32] Power off
:25] Power on

49

Refresh Rate:

Refresh Rate:

[2019/04/29 09:
[2019/04/29 09:
|[2019/04/29 09:

Asterisk Logs

file 'pjsip.conf*

[2019-05-06 17:
[2019-05-06 17:

file "pisip.conf"

[2019-05-06 17:
[2019-05-06 17:

file "pjsip.conf"

[2019-05-06 17:
[2019-05-06 17:

file 'pjsip.conf*

[2019-05-06 17:
[2019-05-06 17:

file 'pjsip.conf*

[2019-05-06 17:
[2019-05-06 17:

'pjsip.conf*

off

v

=
W w

=
W w

=
W w

=
W w

=
w

Off
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:22] Kernel upgrade
:47] Basefs upgrade
:36] Power off

7.3 Asterisk Logs

Figure 2-6-3 Asterisk logs interface

e ————

e e A

:56] ERROR[3224] res_pjsip_endpoint_identifier_ip.c: Identify '104-identify’ is not configured to match anything.
:56] ERROR[3224] res_sorcery_config.c: Could not create an object of type 'identify' with id '104-identify' from configuration

:56] ERROR[3224] res_pjsip_endpoint_identifier_ip.c: Identify '103-identify' is not configured to match anything.
:56] ERROR[3224] res_sorcery_config.c: Could not create an object of type 'identify' with id '103-identify' from configuration

:56] ERROR[3224] res_pjsip_endpoint_identifier_ip.c: Identify '102-identify' is not configured to match anything.
:56] ERROR[3224] res_sorcery_config.c: Could not create an object of type 'identify' with id '102-identify' from configuration

:56] ERROR[3224] res_pjsip_endpoint_identifier_ip.c: Identify '101-identify' is not configured to match anything.
:56] ERROR[3224] res_sorcery_config.c: Could not create an object of type ‘identify" with id '101-identify’ from configuration

:56] ERROR[10052] res_pjsip_outbound_registration.c: Invalid server URI 'sip:' specified on outbound registration 'isp'
:56] ERROR[3224] res_sorcery_config.c: Could not create an object of type ‘registration’ with id 'isp' from configuration file
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7.4 DAHDI Logs

Figure 2-6-6 DAHDI logs interface

Y DAHDI Logs

[
[
[
[
[
[
[
[
[
[
[
[
[
I

[

22.400045] ua32xx: device 0 tdm stopped.

22.516547] usbcore: deregistering interface driver ua32xx
22.522962] dahdi: disable_span: span 1

22.527604] ua32xx: device 0 disconnected.

22.532246] uad2xx exit.

22.783932] ua3d2xx driver ver 0.0.1

22.787922] ua32xx: probe on interface config 0 epnum 4
22.793795] ua32xx: found hardware "UC320", max channels 8, working channels 2
22.851580] ua32xx: fimware 1.0.1 build 994

24.014763] ua32xx: Module 0 Installed -- AUTO FXO (CHINA mode)
24.022071] ua32xx: Module 1 Installed -- AUTO FXS/DPO
26.432819] ua32xx: device 0 tdm started.

26.456897] uad2xx: device 0 used as master.

26.461837] usbcore: registered new interface driver ua32xx
26.922380] dahdi_echocan_oslec: Registered echo canceler 'OSLEC’

[164619.027067] ua32xx: Setting VMWI on channel 1, messages=0, lrev=0, hvdc=0, hvac=0
[164619.035888] uald2xx: Setting VMWI on channel 1, messages=0, lrev=0, hvdc=0, hvac=0
[164619.044657] ua32xx: Setting VMWI on channel 1, messages=0, Irev=0, hvdc=0, hvac=0
[1646232.057386] ua32xx: Setting VMWI on channel 1, messages=0, Irev=0, hvdc=0, hvac=0
[164623.070835] ua32xx: ioctl: Start OnHookTrans, card 1

[164629.292330] ua32xx: Setting VMWI on channel 1, messages=0, Irev=0, hvdc=0, hvac=0
[164629.3201410] ua32xx: Setting VMWI on channel 1, messages=0, Irev=0, hvdc=0, hvac=0
[164629.310308] ua32xx: Setting VMWI on channel 1, messages=0, Irev=0, hvdc=0, hvac=0
[164633.323391] ua3d2xx: Setting VMWI on channel 1, messages=0, Irev=0, hvdc=0, hvac=0
[164633.336833] ua32xx: ioctl: Start OnHookTrans, card 1

Refresh Rate: off ¥ Clean Up Download

7.5 FXO Monitor Logs

Figure 2-6-7 FXO Monitor logs interface

Y FXO Monitor Logs

27/10/2017 13:56:48.411356 fxo-monitor.cpp:313 [silencedetect]->debug not found, use default Disabled
27/10/2017 13:56:48.411426 fxo-monitor.cpp:320 [silencedetect]->debugalgorithm not found, use default Disabled
27/10/2017 13:56:48.411495 fxo-monitor.cpp:324 Silence detect on Tx Enabled

27/10/2017 13:56:48.411582 fxo-monitor.cpp:330 Silence detect threshold 250

27/10/2017 13:56:48.411655 fxo-monitor.cpp:336 Silence detect length 300 seconds

27/10/2017 13:56:48.411724 fxo-monitor.cpp:343 Silence detect frame size 1024 samples
27/10/2017 13:56:48.411800 fxo-monitor.cpp:353 [silencedetect]->action is /etc/fxomon/hangup.sh
27/10/2017 13:56:48.411882 fxo-monitor.cpp:378 Spandsp [supertonedetect]->debug Enabled
27/10/2017 13:56:48.411982 fxo-monitor.cpp:385 Spandsp [supertonedetect]->tones busy0
27/10/2017 13:56:48.412115 Supertone [busy0].segment1=0,0,250,450

27/10/2017 13:56:48.412210 Supertone [busy0].segment2=450,0,250,450

27/10/2017 13:56:48.412312 Supertone [busy0].segment3=0,0,250,450

:56:48.412398 Supertone [busy0].segment4=450,0,250,450

:56:48.412482 Supertone [busy0].segment5=0,0,250,450

:56:48.412557 Supertone detect enabled for busy0

:56:48.412640 Action of tone busy0 is </etc/fxomon/hangup.sh>

:56:48.412722 fxo-monitor.cpp:189 [system]->preecho is Yes

:56:48.412829 fxo-monitor.cpp:201 Dahdi channels => 1,

:56:48.412908 fxo-monitor.cpp:212 Log event channels => 1,

:56:48.413130 fxo-monitor.cpp:218 No channels to record

:56:48.413211 Preamp disabled

:56:48.413275 fxo-monitor.cpp:525 DAHDI r/w block size is 240

:56:48.413567 Enable log for Dahdi channel 1

:56:48.413676 Silence Detect enabled

27/10/2017 13:56:48.413753 Supertone Detect enabled
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7.6 VPN Logs

Figure 2-6-8 VPN logs interface
VPN Logs

Refresh Rate: off v Clean Up openvpn client ¥
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